
 

  

คณะวิศวกรรมศาสตร ์| มหาวิทยาลัยราชธานี 

แนวปฏิบัติที่ด ี เทคนิคการทํางานวิจัยในชั้นเรียน 
 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ก 
 

คํานํา 

 

แนวปฏิบัติที่ดี (Best Practice) เทคนิคการทํางานวิจัยที่เกี่ยวกับการเรียนการสอน เล่ม

น้ี จัดทําข้ึนเพื่อแสดงถึงวิธีการทํางานวิจัยด้านการจิการเรียนการสอน เพ่ือให้ประสบ

ความสําเร็จเป็นที่ยอมรับในวงวิชาการ โดยเริ่มตั้งแต่การประเมินผลการเรียนการสอนใน

รูปการวิเคราะห์แบบต่างๆ จนถึงการใช้โปรแกรมทางสถิติช่วยในการวิเคราะห์ดังในเอกสารชุด

น้ี ได้ใช้โปรแกรมวิเคราะห์ข้อมูลทางสถิติ spss เป็นตัวช่วยในการวิจัย ทําให้ผู้ที่จะทําการสอน

สามารถประเมินผู้เรียนได้รอบด้าน 

คณะวิศวกรรมศาสตร์หวังว่าคู่มือแนวปฏิบตัิทีดี่ (Best Practice) ฉบับนี้จะเป็นประโยชน์

ต่อการดําเนินการตามพันธกิจด้านการวิจัยของคณะ และของมหาวิทยาลัยเป็นอย่างดี และยัง

จะเป็นประโยชน์ต่อผู้สนใจอีกทางหนึ่งด้วย  
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การวิจัยในช้ันเรียน 

 

แนวทางการทําวิจัยในชั้นเรียน 

1. การวิจัยเชิงปฏิบัติการในช้ันเรียน คือ การดําเนินการศึกษาวิเคราะห์เกี่ยวกับวิธีการ

จัดการเรียนการสอนของอาจารย์ผู้สอน เพ่ือปรับปรุงการสอนของตนเองและพัฒนาการเรียนรู้ของ

นักศึกษาให้มีคุณภาพและประสิทธิภาพให้ดีมากข้ึนกว่าเดิม 

2. ข้ันตอนการวิจัย มี 5 ข้ัน ดังนี้ 

- ระบุปัญหา 

- วางแผน/ปฏิบัติการสอน 

- เก็บรวบรวมข้อมูล 

- วิเคราะห์ข้อมูล 

- วางแผน/ปฏิบัติการสอนต่อไป 

3. การสํารวจและวิเคราะห์ปัญหาด้านการจัดการเรียนการสอน โดยเป็นเป็นการ

พิจารณาจากปัญหาที่เกิดข้ึนของนักศึกษารายบุคคลหรือเป็นกลุ่ม  รวมถึงพิจารณาผลสัมฤทธิ์ทาง

การศึกษาของนักศึกษา 

4. เมื่อพบปัญหาแล้วให้ตัดสินใจว่าปัญหาใดเป็นปัญหาที่สําคัญที่สุด  อยู่ในวิสัยที่ต้องแก้

ก่อน (needs คือความจําเป็นที่ต้องแก้ไข) โดยคํานึงถึงคําถามในการกําหนดปัญหา  เช่น ปัญหามี

ความสําคัญหรือร้ายแรงแค่ไหน  ทําไมถึงเกิดปัญหา  ปัญหาอย่างเดียวกันอาจมีสาเหตแุตกต่างกนั เรา

หาความรู้จากที่อ่ืนมาแก้ปญัหาได้หรือไม ่(ถ้าแก้ปัญหาทันทีได้หรือมีความรู้อยู่แล้ว  ไม่ต้องเสียเวลาทาํ

การวิจัย)  งานวิจัยนี้มีท่าทีว่าจะสําเร็จหรือไม่  ทําแล้วได้ประโยชน์อะไร  คุ้มค่ากับการลงทุนหรือไม่   

5. กําหนดวัตถุประสงค์ให้ชัดเจน  เป็นรูปธรรม มีความเหมาะสม  ทันเวลา  นักวิจัย

สามารถทําได้  ถ้าจะมีหลายวัตถุประสงค์แต่ละข้อต้องมีความสัมพันธ์กัน เช่น เพ่ือ... วัด.. ทดสอบ.. 

เปรียบเทียบ.. แก้ไข.. ฯลฯ   

6. การเก็บรวบรวมข้อมูล อาจใช้เครื่องมือหลายๆ อย่างในการเก็บรวบรวมข้อมูล ได้แก่ 

แบบสอบถาม  แบบสํารวจ  แบบสัมภาษณ์  แบบบันทึก  แบบวัดเจตคติ ฯลฯ  

7. เทคนิคการวัดประเมินผลในช้ันเรียน ได้แก่ การสังเกตบันทึก สนทนาบันทึก ตรวจ

บันทึก สอบถามบันทึก ทดสอบบันทึก 

8. การศึกษาเอกสารและงานวิจัยที่เกี่ยวข้องเป็นการศึกษาทฤษฏีต่างๆ หรือสํารวจ

ตรวจดูว่ามีใครทํางานวิจัยทํานองนี้แล้วหรือยัง  ได้ผลอย่างไรและยังอาจใช้ในการตัดสินใจวางแผนการ

แก้ไขปัญหาตามวัตถุประสงค์ที่ตั้งไว้   
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การเขียนงานวิจัยในชั้นเรียน 

การวิจัยในช้ันเรียนเป็นการวิจัยเชิงคุณภาพ  ซ่ึงเกิดข้ึนจากการค้นคว้าทดลองแสวงหาความ

จริงเชิงวิทยาศาสตร์อย่างใกล้ชิดในสถานการณ์จริงในชั้นเรียน  ไม่มีรูปแบบการเขียนรายงานที่เป็น

สากล  เน้นรูปแบบที่เรียบง่าย  ใช้การบรรยายเป็นหลักในการนําเสนอข้อค้นพบที่เป็นองค์ความรู้ใหม่

จากการแก้ปัญหา  ซ่ึงก็ข้ึนอยู่กับว่าผู้วิจัยจะมีความสามารถในการบันทึกรายละเอียดขององค์ประกอบ

ต่าง ๆ ที่เกิดข้ึนจากการวิจัยได้มากน้อยหรือดีเพียงใด   

1. การเขียนรายงานวิจยัในช้ันเรียนควรมีองค์ประกอบที่สําคัญดังนี้ 

1) ช่ือเรื่องการวิจัย 

2) ปัญหาและความสําคัญของปัญหา 

3) วัตถปุระสงค์ของการวิจัย 

4) วิธีการวิจัย 

    4.1  กลุ่มเป้าหมาย 

    4.2  วิธีการหรือนวัตกรรมทีใ่ช้  

    4.3  วิธีการรวบรวมข้อมลู 

    4.4  วิธีการวิเคราะห์ข้อมลู 

    4.5  ผลการวิเคราะห์ข้อมลู 

5) สรุปและสะท้อนผล 

2. การเขียนรายงานการวิจัยในช้ันเรียนให้น่าเช่ือถือและยอมรับได้  ควรคํานึงถึงสิ่ง

ต่อไปนี้ 

1) ปัญหาที่นํามาวิจัยต้องเป็นปัญหาที่แท้จริง  มีข้อมูลชัดเจนว่าเป็นปัญหา  ไม่ใช่เป็น

เพียงสาเหตุของปัญหา  เป็นปัญหาที่สามารถหาคําตอบได้ด้วยการวิจัยและเป็น

องค์ความรู้ใหม่ 

2) ช่ือเรื่องการวิจัยหรือช่ือปัญหาวิจัยต้องมีความกะทัดรัด  และชัดเจนในตัวของมัน

เอง  เฉพาะเจาะจงและน่าสนใจ  คําว่า  การศึกษาเก่ียวกับ  การวิจัย  การ

ทดลอง  การวิเคราะห์   การสํารวจ   หรือการค้นหาก็ตาม  คําเหล่าน้ี

ไม่จําเป็นต้องใช้ 

3) วัตถุประสงค์ของการวิจัยควรใช้ภาษาท่ีชัดเจน  เข้าใจง่าย  ไม่วกวน  หลีกเล่ียง

การใช้คําซ้ําซ้อน  นําไปสู่การตั้งสมมุติฐานและสามารถทําการทดสอบได้ 

4) วิ ธีการวิจัยมีความถูกต้องมีข้อมูลครบถ้วนและถูกต้องตามความเป็นจริง  

เครื่องมือที่ใช้ในการเก็บรวบรวมข้อมูล  วิธีการวิเคราะห์ข้อมูล  และผลการ

วิเคราะห์ข้อมูลมีความเที่ยงตรง 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๓ 
 

5) การส่ือความหมายตั้งแต่ต้นจนจบมีความชัดเจน  สอดคล้องต่อเนื่อง  ผู้อ่าน

สามารถเข้าใจได้ดี 

 ปัจจัยที่มีผลต่อการเขียนงานวิจัยในชั้นเรียน 

1. การกําหนดปญัหาที่ชัดเจน 

2. การเก็บรวบรวมข้อมูล 

3. การสืบค้นข้อมูล รูจ้ักฐานข้อมูลที่เกีย่วข้องกับงานวิจยั 

4. การสังเกต และสัมภาษณ์ 

5. ความรู้ความเข้าใจในการใช้ภาษาในการเขียนงานวิจัย 

 ปัญหาและอุปสรรคในการทํางานวิจัยในชั้นเรียน 

1. ปัญหาจากการไม่เคยเขียนงานวิจัยในช้ันเรียน ขาดผู้ช้ีแนะ 

2. ไม่มีแรงจูงใจในการทํางานวิจัย 

3. ไม่มีเวลาในการเกบ็รวบรวมข้อมูล 

 

การใช้สถิติเพื่อการวิเคราะห์ข้อมูล 

หลังจากที่ได้เก็บหรือรวบรวมข้อมูลและดําเนินการจัดระเบียบข้อมูลให้อยู่ในสภาพที่เรียบร้อย

พร้อมที่จะนําไปวิเคราะห์ได้แล้ว งานในข้ันต่อไปของผู้วิจัยคือการตัดสินใจว่าจะนําสถิติอะไรมาใช้ ซ่ึงใน

การนี้ผู้วิจัยจะต้องทราบตั้งแต่แรกว่าข้อมูลที่มีอยู่ในลักษณะใดและต้องการเสนอผลการวิเคราะห์อะไร  

 ข้อมูลที่เกบ็รวบรวมมาได้บางครั้งยังมีรูปแบบทีก่ระจดักระจายเปน็รายบุคคล ไม่เปน็ระบบ 

จําเปน็ต้องมีกระบวนการจัดกระทําข้อมูลเหล่านั้นให้เปน็ระบบหรือเปน็หมวดหมู่เกิดเปน็สารสนเทศที่

สามารถนําไปใช้ประโยชน์ เพื่อสรุปอ้างอิงไปยังประชากรต่อไป ศาสตร์ที่ถกูนําเข้ามาช่วยในข้ันตอนของ

การตรวจสอบคุณภาพของเครื่องมือไปจนถึงการอ้างอิงเหล่านี้ เรียกว่า สถิติ  

 

ความหมายของสถิติ 

คําว่าสถิติ (Statistics) มาจากภาษาเยอรมนัว่า Statistics มีรากศพัท์มาจาก Stat  หมายถึง    

ข้อมูลหรือสารสนเทศ ซ่ึงจะอํานวยประโยชน์ต่อการบริหารประเทศในด้านต่างๆ เช่น การทํา

สํามะโนครัวเพื่อจะทราบจํานวนพลเมืองในประเทศท้ังหมด ในสมัยต่อมา คําว่า สถิติ ได้หมายถึง ตัวเลข

หรือข้อมูลทีไ่ด้จากการเกบ็รวบรวม  เช่น จํานวนผู้ประสบอุบตัิเหตุบนท้องถนน  อัตราการเกิดของเด็ก

ทารก  ปริมาณน้ําฝนในแต่ละปี  เป็นตน้  สถิติในความหมายที่กล่าวมานี้เรียกอีกอย่างหนึ่งว่า  ข้อมูล

ทางสถิติ (Statistical data)  
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อีกความหมายหนึง่ สถิติ  หมายถึง วิธีการที่ว่าด้วยการเก็บรวบรวมข้อมูล การนําเสนอ     

ข้อมูล  การวิเคราะห์ข้อมูล  และการตีความหมายข้อมูล  สถิติในความหมายนี้เป็นทั้งวิทยาศาสตร์และ

ศิลปศาสตร์ เรียกว่า สถิติศาสตร ์

 

ประเภทของสถิติ 

สถิติแบ่งเปน็ 2 ประเภท คือ 

1. สถิติพรรณนา (Descriptive Statistics)  

เป็นสถิติที่ใช้อธิบายคุณลักษณะของสิ่งที่ต้องการศึกษากลุ่มใดกลุ่มหนึง่ ไม่สามารถอ้างอิง

ไปยงักลุ่มอ่ืนๆ ได้  สถิติทีอ่ยู่ในประเภทนี้  เช่น  ค่าเฉลี่ย  ค่ามธัยฐาน  ค่าฐานนิยม          ส่วนเบีย่งเบน

มาตรฐาน  ค่าพิสัย ฯลฯ 

 

2. สถิติอ้างอิง (Inferential statistics)  

เป็นสถิติที่ใช้อธิบายคุณลักษณะของสิ่งที่ต้องการศึกษากลุ่มใดกลุ่มหนึง่หรือหลายกลุ่ม  

แล้วสามารถอ้างอิงไปยงักลุ่มประชากรได้  โดยกลุ่มที่นํามาศึกษาจะต้องเป็นตัวแทนที่ดีของประชากร  

ตัวแทนที่ดีของประชากรได้มาโดยวิธีการสุ่มตัวอย่าง  และตัวแทนที่ดีของประชากรเรียกว่า  กลุ่ม

ตัวอย่าง  สถิติอ้างอิงแบ่งได้เป็น 2 ประเภท คือ 

  2.1 สถิติพารามิเตอร์ (Parametric Statistics ) เปน็วิธีการทางสถิติที่จะต้องเปน็ไปตาม

ข้อตกลงเบื้องต้น  3  ประการ  ดังน้ี 

(1) ข้อมูลที่เกบ็รวบรวมได้จะต้องอยู่ในระดับช่วงข้ึนไป (Interval Scale) 

(2) ข้อมูลที่เกบ็รวบรวมได้จากกลุ่มตัวอย่างจะต้องมีการแจกแจงเปน็โค้งปกติ 
(3) กลุ่มประชากรแต่ละกลุ่มทีน่ํามาศึกษาจะต้องมีความแปรปรวนเท่ากัน 

สถิติที่อยู่ในประเภทนี้  เช่น  t-test,  Z-test,  ANOVA,  Regression  ฯลฯ 

  2.2 สถิตไร้พารามิเตอร ์ (Nonparametric Statistics) เป็นวิธีการทางสถิติทีส่ามารถ

นํามาใช้ได้โดยปราศจากข้อตกลงเบื้องต้นท้ัง 3 ประการข้างต้น  สถิติที่อยู่ในประเภทนี้ เช่น       ไคส

แควร,์  Median Test,  Sign test  ฯลฯ 

 

แนวความคิดพื้นฐานทางสถิติอ้างอิง 

 ในการเก็บรวบรวมข้อมูลการวิจัยส่ิงแรกที่นักวิจัยจะต้องกําหนดคือ ประชากรที่ต้องการศึกษา 

จากนั้นนักวิจัยต้องพิจารณาต่อไปว่าสามารถรวบรวมข้อมูลจากประชากรท้ังหมดหรือไม่ ถ้าไม่ได้ก็ต้อง

ทําการศึกษาเพียงบางส่วนของประชากรเท่าน้ัน การที่ประชากรที่นักวิจัยสนใจมีขนาดใหญ่คือมีจํานวน

มากไม่สามารถศึกษาทุกหน่วยของประชากรได้และจะต้องเป็นเหตุให้ต้องเลือกกลุ่มตัวแทนของ
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ประชากรมาใช้ในการศึกษา ซ่ึงเราเรียกกันโดยท่ัวไปว่า กลุ่มตัวอย่าง โดยที่ค่าต่างๆ ที่คํานวณได้จึงมี

ช่ือเรียกตามกลุ่มตัวอย่างและประชากรที่ใช้ในการศึกษา แบ่งออกเป็น 2 ชนิด คือ 

 1. พารามิเตอร์ (Parameter) คือ ค่าต่างๆ ที่รวบรวมมาจากประชากรหรือคํานวณได้จาก

ประชากร ใช้อักษรกรีกเป็นสัญลักษณ์ ได้แก่ 

 แทนค่า ค่าเฉลี่ยเลขคณิต 

 แทนค่า ส่วนเบี่ยงเบนมาตรฐาน 

2 แทนค่า ความแปรปรวน 

 แทนค่า สัมประสิทธิ์สหสัมพันธ์ 

 

2. ค่าสถิติ (Statistic) คือค่าต่างๆ ที่รวบรวมมาจากกลุ่มตัวอย่างหรือคํานวณได้จากกลุ่ม

ตัวอย่าง ใช้ตัวภาษาอังกฤษเป็นสัญลักษณ์ ได้แก่ 

x  แทนค่า ค่าเฉลี่ยเลขคณิต 

s แทนค่า ส่วนเบี่ยงเบนมาตรฐาน 

s2 แทนค่า ความแปรปรวน 

r แทนค่า สัมประสิทธิ์สหสัมพันธ์ 

 

แนวคิดพ้ืนฐานของการวิเคราะห์ข้อมูลทางสถิต ิ

 

 การสุ่มตัวอย่าง 

 

 

 

 

  

 

 

 

 

สิ่งที่ต้องพิจารณาในการเลือกใช้ชนิดทางสถิติ 

 ในการพิจารณาในการเลือกใช้ชนิดทางสถิติน้ัน จะต้องมีการคํานึงถึงจุดมุ่งหมายหรือ

วัตถุประสงค์ของการวิจัย ซ่ึงโดยทั่วไปแบ่งจุดมุ่งหมายหรือวัตถุประสงค์ของการวิจัยได้ดังต่อไปนี้ 

ประชากร 
(population) 
ขนาด N 

กลุ่มตวัอยา่ง 
(sample) 
ขนาด n 

ค่าสถิติ 
(statistic) 

ค่าพารามิเตอร์ 
(parameter) 

อ้างองิ 
 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๖ 
 

 1.เพ่ือบรรยายลักษณะตัวแปรในกลุ่มตัวอย่างหรือประชากร เป็นการใช้สถิติบรรยาย 

มาบรรยายภาพรวมของกลุ่มตัวอย่าง ประกอบด้วย 

- การแจกแจงความถ่ีและค่าร้อยละ และนําผลจากการแจกแจงความถี่

หรือค่าร้อยละเพ่ือแสดงภาพรวมของข้อมูลที่ได้ ในการนําเสนอนิยมใช้

ตารางและแผนภูมิมากกว่าคําบรรยายเพียงอย่างเดียว 

- การวัดแนวโน้มเข้าสู่ส่วนกลาง ได้แก่ ค่าเฉลี่ยเลขคณิต มัธยฐาน ฐาน

นิยม 

- การวัดการกระจาย ได้แก่ ส่วนเบี่ยงเบนมาตรฐาน  

 

2. เพ่ือเปรียบเทียบหาความแตกต่าง และสรุปอ้างอิงหาความแตกต่างจากกลุ่ม

ตัวอย่างกลับไปยังประชากรที่ศึกษา ได้แก่ 

- การเปรียบเทียบค่าเฉล่ียของกลุ่มตัวอย่าง 2 กลุ่มที่เป็นอิสระกันด้วย  

Independent t-test  

- การเปรียบเทียบค่าเฉล่ียของกลุ่มตัวอย่าง 2 กลุ่มที่ไม่เป็นอิสระต่อกันด้วย  

pair t-test  

- การเปรียบเทียบค่าเฉล่ียของกลุ่มตัวอย่างตั้งแต่ 2 กลุ่มด้วย Anova 

- การเปรียบเทียบความถี่และสัดส่วนด้วยไคสแควร์ 

3. เพ่ือบรรยายความสัมพันธ์ระหว่างตัวแปร ได้แก่ การใช้สหสัมพันธ์อย่างง่าย ในการ

บรรยายความสัมพันธ์ระหว่าง 2 ตัวแปร เช่น การวิเคราะห์ค่าสหสัมพันธ์แบบเพียร์สัน (Pearson’s 

product moment coefficient of correlation) และสห สัม พัน ธ์แบบส เปี ยร์ แมน  (Spearman’s 

Correlation) และการใช้สหสัมพันธ์พหุคูณ ในการบรรยายความสัมพันธ์ระหว่างตัวแปรตั้งแต่ 2 ตัวข้ึน

ไป 
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การทดสอบสมมติฐาน (Hypothesis testing) 

 

สมมติฐาน ( Hypothesis ) มี 2 ชนิด คือ สมมติฐานทางการวิจยั (Research hypothesis) กับ

สมมติฐานทางสถิติ (Statistical hypothesis) การวิจัยบางเรื่องอาจไม่มีสมมติฐานการวิจัยก็ได้ ส่วนที่ มี

สมมติฐานมักเป็นการหาความสัมพันธ์ระหว่างตัวแปร เช่น ศึกษาความสัมพันธ์ระหว่างความถนัด

ทางการเรียนกับผลสัมฤทธิ์ทางการเรียน เปน็ต้น  หรือเป็นการวิจัยทีอ่ยู่ในลักษณะที่เปน็การ

เปรียบเทียบ เช่น ความมีวินยัในตนเองระหว่างนกัเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีต่างกนั 

 กระบวนการทดสอบสมมติฐาน จะช่วยผู้วิจัยในการตัดสินใจสรุปผลว่ามีความสัมพันธ์กัน

ระหว่างตัวแปรจริงหรือไม่ หรือช่วยใจการตัดสินใจเพ่ือสรุปผลว่าสิ่งที่นํามาเปรียบเทียบกันนั้นแตกต่าง

กันจริงหรือไม่  สําหรับหัวข้อสําคัญที่จะกล่าวถึงคือ ความหมายของสมมติฐาน ประเภทของสมมติฐาน 

ข้ันตอนการทดสอบสมมุติฐาน ชนิดของความคลาดเคลื่อน ระดับนัยสําคัญ และการทดสอบสมมุติฐาน

แบบมีทิศทางและแบบไม่มีทิศทาง 

 

ความหมายของสมมุติฐาน 

 สมมุติฐาน คือ คําตอบที่ผู้วิจัยคาดคะเนไว้ล่วงหน้าอย่างมีเหตุผล หรือสมมตุิฐานคือข้อความที่

อยู่ในรูปของการคาดคะเนความสัมพันธ์ระหว่างตัวแปร 2 ตัว หรือมากกว่า 2 ตัวเพื่อใช้ตอบปัญหาที่

ต้องการศึกษา สมมตุิติฐานที่ดีมีหลักเกณฑ์ที่สําคัญ 2 ประการคือ 

1. เป็นข้อความที่กล่าวถึงความสัมพันธ์ระหว่างตัวแปร 

2.เป็นสมมุติฐานที่สามารถทดสอบได้โดยวิธีการทางสถิต ิ

 

ประเภทของสมมุติฐาน  สมมุติฐานมี 2 ประเภท คือ  

1. สมมุติฐานทางการวิจัย (Research hypothesis) เปน็คําตอบที่ผู้วิจยัคาดคะเนไว้ล่วงหน้า 

และเปน็ข้อความที่แสดงความเกี่ยวข้องระหว่างตัวแปร ตัวอย่างเช่น  

ตัวอย่างที่ 1 นักเรียนในกรงุเทพฯจะมีทศันะคติทางวิทยาศาสตร์ดีกว่านักเรียนในชนบท 

ตัวอย่างที่ 2 ผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังเข้า

ค่ายของนักศึกษา 

ตัวอย่างที่ 3 นักเรียนที่ได้รับการอบรมเลี้ยงดูด้วยวิธีการต่างกนัจะมีวินัยในตนเอง

ต่างกนั 

ตัวอย่างที่ 4 ความถนดัทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิท์างการ

เรียน 

สมมุติฐานดังกล่าวเปน็เพียงการคาดคะเน ยงัไม่เปน็ความรูที้่เช่ือถือได้ จนกว่าจะ 
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ได้รบัการทดสอบโดยใช้วิธีการทางสถิต ิ

ตัวอย่างที่ 1 มีตัวแปรที่เกีย่วข้อง 2 ตัว คือ 1) ภูมิลําเนาของนักเรียน 2) ทศันะคติทาง

วิทยาศาสตร ์

ตัวอย่างที่ 2 มีตัวแปรที่เกีย่วข้อง 2 ตัวคือ 1) ผลการเรียนรู้ก่อนเข้าค่าย 2) ผลการ

เรียนรู้หลังเข้าค่าย 

ตัวอย่างที่ 3 มีตัวแปรที่เกีย่วข้อง 2 ตัว คือ 1) วิธีการอบรมเลี้ยงดู 2) วินัยในตนเอง 

ตัวอย่างที่ 4 มีตัวแปรที่เกีย่วข้อง 2 ตัว คือ 1) ความถนัดทางการเรียน และ  2) 

ผลสัมฤทธิ์ทางการเรียน 

 

สมมุติฐานทางการวิจัย มี 2 ชนิดคือ 

1. สมมตุิฐานทางการวิจัยมีแบบมีทิศทาง (Directional hypothesis) เป็นสมมตุิฐานที่

เขียนระบุอย่างชัดเจนถึงทิศทางของความแตกต่างถึงทิศทางของความแตกต่างระหว่างกลุ่ม โดยมีคํา

ว่า   “ ดีกว่า ” หรือ  “ สงูกว่า ” หรือ “ ต่ํากว่า ” หรือ “ น้อยกว่า” ในสมมตุิฐานนั้นๆ ดัง

ตัวอย่างที ่1 และที่ 2 ข้างต้น หรือระบทุิศทางของความสัมพันธ์ โดยมีคําว่า “ ทางบวก ” หรือ “ทาง

ลบ ” ดังตัวอย่างที่ 4 ข้างต้น ยกตัวอย่างเช่น  

  - ผู้บริหารเพศชายมีประสิทธิภาพในการบริหารงานมากกว่าผู้บริหารเพศหญิง 

  - ผู้บริหารชายมีการใช้อํานาจในตําแหน่งมากกว่าผู้บริหารหญิง 

  - ครูอาจารย์เพศชายมีความวิตกกังวลในการทํางานน้อยกว่าครูอาจารย์เพศหญิง 

  - เจตคติต่อวิชาวิจัยทางการศึกษามีความสัมพันธท์างบวกกับผลสัมฤทธิ์ทางการ

เรียนวิชาวิจัยทางการศึกษา 

  2. สมมุติฐานทางการวิจยัไม่มีแบบไม่มีทิศทาง (Non-directional hypothesis ) เป็น

สมมุติฐานที่ไม่กําหนดทิศทางของความแตกต่างดังตวัอย่างที ่ 3 หรือไม่กําหนดทิศทางของ

ความสัมพันธ์  ดังตวัอย่าง 

- นักเรียนที่มีเพศต่างกนัมีเจตคติต่อวิชาคณิตศาสตร์แตกต่างกัน 

    - ผู้บริหารทีม่ีเพศต่างกันมีปัญหาในการบริหารงานวิชาการแตกตา่งกัน 

- ภาวะผู้ของผู้บริหารมีความสัมพันธก์บับรรยากาศองค์การ 

 

2. สมมุติฐานทางสถิติ (Statistical hypothesis) เป็นสมมตุิฐานทีต่ั้งข้ึนเพ่ือใช้ทดสอบว่า 

สมมุติฐานทางการวิจัยที่ผู้วิจัยตั้งไว้เป็นจริงหรือไม่ เปน็สมมตุิฐานที่เขียนอยู่ในรูปแบบของโครงสร้าง

ทางคณิตศาสตร์ เพื่อให้อยู่ในรูปที่สามารถทดสอบได้ด้วยวิธีการทางสถิติ สัญลักษณ์ที่ใช้เขียนใน

สมมุติฐานทางสถิติจะเปน็พารามิเตอร์เสมอ ที่พบบ่อยๆได้แก่  
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  (อ่านว่า  มิว) แทนตัวกลางเลขคณิตหรือค่าเฉล่ียของกลุ่มประชากร 

 ( อ่านว่า  โร ) แทนสหสัมพันธ์ระหว่างตัวแปร  

 ( อ่านว่า ซิกมา ) แทนความเบี่ยงเบนมาตรฐานของกลุ่มประชากร 

 

สมมุติฐานทางสถิติ มี 2 ชนิดคือ 

2.1 สมมุติฐานที่เปน็กลางหรือสมมุติฐานทีไ่ร้นัยสําคัญ (Null hypothesis) สัญลักษณ์ที่ใช้ คือH0  

2.2 สมมุติฐานทางเลือก (Alternative hypothesis) สัญลักษณ์ทีใ่ช้ คือ  H1  

 ในการวิจัยหลังจากทีต่ั้งความมุ่งหมายของการวิจัยแล้ว ผู้วิจัยมักจะตั้งสมมตุิฐานทางการวิจยั

เพื่อคาดคะเนคําตอบไว้ล่วงหน้า แล้วจึงเก็บรวบรวม ข้อมูลเพื่อทําการทดสอบสมมุติฐานทางการวิจัย

ที่ตั้งไว้ โดยจะต้องแปลงสมมุติฐานทางการวิจัยให้เป็นสมมตุิฐานทางสถิติก่อน จึงจะทดสอบได้ด้วย

วิธีการทางสถิติเวลาตั้งสมมุติฐานทางสถิติจะต้องตั้งทั้ง Null hypothesis และ Alternative hypothesis  

 สมมุติฐานไร้นัยสําคัญ แทนด้วย H0 เปน็สมมุติฐานทีแ่สดงให้เห็นว่าไม่มีความแตกต่างระหว่าง

กลุ่มหรือไม่มีความสัมพันธ์ระหว่างตัวแปร เช่น 

  H0     : 1   =   2  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรกลุ่มที่ 1 และกลุ่มที่ 2 เท่ากันหรือไม่มีความแตกต่าง

กัน 

หรือ H0     : ก่อน   =   หลงั  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรก่อนและหลังการทดลองเท่ากันหรือไม่มีความ

แตกต่างกัน 

หรือ H0     : 1   =   2   =  3  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรกลุ่มที ่ 1 และกลุ่มที ่ 2 และกลุ่มที ่ 3 เท่ากันหรือไม่มี

ความแตกต่างกัน 

 หรือ H0     :      =    0 

หมายความว่าไม่มีความสัมพันธ์ระหว่างตัวแปร X กับตัวแปร Y  

 

สมมุติฐานทางเลือก แทนด้วย  H1    เป็นสมมุติฐานที่แสดงให้เห็นว่ามีความแตกต่างระหว่าง

กลุ่มหรือมีความสัมพันธ์ระหว่างตัวแปร เช่น    

  H1     : 1       2  

หมายความว่าค่าเฉลี่ยของกลุ่มประชากร กลุ่มที ่1 และกลุ่มที่ 2 ไม่เท่ากันหรือมีความแตกต่าง

กัน 

หรือ H1     : ก่อน       หลงั  
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หมายความว่าค่าเฉลี่ยของกลุ่มประชากรก่อนและหลังการทดลองไม่เท่ากันหรือมีความ

แตกต่างกัน 

หรือ H1     : 1      2      3  หรือ มีค่า  อย่างน้อย 1 คู่ทีไ่ม่เท่ากัน 

หมายความว่าค่าเฉลี่ยของกลุ่มประชากรกลุ่มที ่ 1 และกลุ่มที ่ 2 และกลุ่มที ่ 3 ไม่เท่ากันหรือมี

ความแตกต่างกัน 

หรือ H1      :         0 

 หมายความว่ามีความสัมพันธ์ระหว่างตัวแปร  

 

การตั้งสมมุติฐาน กรณีที่เป็นงานวิจยัในลักษณะเปรียบเทียบ   จะมีได้   3  ลักษณะ ดังน้ี 

 H0     : 1   =   2  (เท่ากันหรือไม่แตกต่างกัน) 

H1     :  1     2   (ไม่เท่ากันหรือต่างกัน) 

H0     : 1   =   2  (เท่ากันหรือไม่แตกต่างกัน) 

     H1     :  1      2  (มากกว่า) 

H0     : 1   =   2  (เท่ากันหรือไม่แตกต่างกัน) 

 H1     :  1    <  2   (น้อยกว่า) 

 

ในกรณีทีเ่ปน็งานวิจยัที่ศึกษาความสัมพันธ์ระหว่างตัวแปร H1  มีได้ 3 ลักษณะดังนี้  

H0  :   =  0 (ไม่มีความสัมพันธ์กัน) 

H1   :  0  (มีความสัมพันธ์กัน) 

     H0  :   = 0 (ไม่มีความสัมพันธ์กัน) 

H1   :  0  (มีความสัมพันธ์เชิงบวก) 

 H0  :    = 0 (ไม่มีความสัมพันธ์กัน) 

H1   :  0  (มีควาสัมพนัธ์เชิงลบ) 

  

ข้อสังเกต รปูแบบในการเขียนสมมุติฐานทางสถิติแต่ละครั้งจะต้องเขียนให้สอดคล้องกับ

สมมุติฐานทางการวิจัยซ่ึงอาจเขียนได้แตกต่างกัน และเพ่ือที่จะสามารถเลือกใช้สถิติที่จะทําการทดสอบ

ได้อย่างถูกต้องตรงตามสมมุติฐานที่ตั้งไว้ 

 

ยกตัวอย่าง เช่น 

ตัวอย่างที่ 1 นักเรียนในกรงุเทพฯจะมีทศันะคติทางวิทยาศาสตร์ดีกว่านักเรียนในชนบท 
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จากตัวอย่างที่ 1 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ภมิูลําเนาของนักเรียน (กรุงเทพฯ และชนบท) 

2) ทัศนะคติทางวิทยาศาสตร์ (วัดออกมาเป็นตัวเลข) 

 การตั้งสมมุติฐาน H0     : 1   =   2  

   H1     :  1     2  

 โดยที ่ 1 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในกรุงเทพ 

  2 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในชนบท 

 สถิติทีจ่ะใช้ในการทดสอบ คือ Independent t-test 

 

 ตัวอย่างที่ 2 ผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรูห้ลังเข้าค่ายของ

นักศึกษา 

จากตัวอย่างที่ 2 มีตัวแปรที่เกี่ยวข้อง 2 ตัวคือ 1) ผลการเรียนรู้ก่อนเข้าค่าย (วัดออกมาเปน็

ตัวเลข) 2) ผลการเรียนรูห้ลังเข้าค่าย (วัดออกมาเปน็ตัวเลข) 

การตั้งสมมุติฐาน H0     : ก่อน     =   หลงั  

   H1     :  ก่อน   <   หลงั  

 โดยที ่ ก่อนคือ ค่าเฉลี่ยของผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษา 

หลงัคือ ค่าเฉลี่ยของผลการเรียนรู้หลังเข้าค่ายของนักศึกษา 

 สถิติทีจ่ะใช้ในการทดสอบ คือ Pair t-test 

 

ตัวอย่างที่ 3 นักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีการต่างกนัจะมีวินัยในตนเองต่างกัน 

จากตัวอย่างที่ 3 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) วิธีการอบรมเลี้ยงดู (มีหลายวิธี) 2) วินัยใน

ตนเอง (วัดออกมาเปน็ตัวเลข) 

การตั้งสมมุติฐาน H0     : 1   =   2   =  3  

   H1     : 1      2      3   

หรือ มีค่า  อย่างน้อย 1 คู่ทีไ่ม่เท่ากัน 

 โดยที ่ 1 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีที ่1 

  2 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีที ่2 

3คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีที ่3 

 สถิติทีจ่ะใช้ในการทดสอบ คือ ANOVA 

 

ตัวอย่างที่ 4 ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการเรียน 
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 จากตัวอย่างที่ 4 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ความถนัดทางการเรียน (วัดออกมาเปน็

ตัวเลข) และ  2) ผลสัมฤทธิท์างการเรียน (วัดออกมาเป็นตัวเลข) 

 การตั้งสมมุติฐาน H0     :     =   0 

H1      :     >   0 

 โดยที ่   คือ ความสัมพันธ์ระหว่างความถนัดทางการเรียนกบัผลสัมฤทธิ์ทางการเรียน 

 สถิติทีจ่ะใช้ในการทดสอบ คือ ค่าสหสัมพันธ์แบบเพียร์สัน 

 

ขั้นตอนการทดสอบสมมุติฐาน  

 1. การทดสอบสมมุติฐานมีข้ันตอนดังนี้ (คํานวณด้วยมือ) 

ขั้นที่ 1 ตั้งสมมุติฐานทางสถิต ิ

ขั้นที่ 2 กําหนดระดับนัยสําคัญทางสถิติ(กําหนด  ) และหาอาณาเขตวิกฤตหรืออาณาเขตที่จะ    ปฎิ

เศษ H0  (ได้จากตารางสถิติ) 

2.1 การทดสอบแบบมีทิศทาง หรือบางทีเรียกว่า การทดสอบแบบหางเดียว ( One- tailed test 

) มี 2 กรณี คือ  

 

  กรณีหางเดียวทางขวาH1     : 1   >   2  

 

       ยอมรบั   oH                                                ปฎิเสธ  oH     

 

 

                                                                                              
 

 

  กรณีหางเดียวทางซ้าย H1     : 1   <   2  

 

ปฎิเสธ  oH                                                  ยอมรบั   oH  

              

             
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2.2 แบบไม่มีทิศทาง หรือการทดสอบแบบสองหาง ( Two - tailed test ) ซ่ึงเปน็การทดสอบเมื่อ

H1     : 1       2  

                                     ยอมรบั oH     

ปฎิเสธ  oH                                                                       ปฎิเสธ  oH                                                

                                                         

 

           
2

                                                               
2

                         

 

 

ขั้นที่ 3 คํานวณค่าสถิติทีใ่ช้ทดสอบสมมุติฐาน 

ขั้นที่ 4 นําค่าสถิติทีไ่ด้ไปเปรียบเทียบกับค่าวิกฤตที่ได้จากตารางสถิติ  

ขั้นที่ 5 การตดัสินใจ มี 2 กรณี 

1. ถ้าค่าที่คํานวณได้ตกอยู่ในอาณาเขตวิกฤตจะปฏิเสธ (reject) H0 ยอมรบั (accept) H1    

2. ถ้าค่าสถิติที่คํานวณได้อยู่นอกอาณาเขตวิกฤตยอมรับH0     

  

 2. การทดสอบสมมุติฐานด้วยโปรแกรมคอมพิวเตอร ์

ขั้นที่ 1 ตั้งสมมุติฐานทางสถิต ิ

ขั้นที่ 2 กําหนดระดับนัยสําคัญทางสถิติ (กําหนด  ) และหาอาณาเขตวิกฤต (อาณาเขตที่จะปฎิเศษ 

H0 ) 

2.1 การทดสอบแบบมีทิศทาง หรือบางทีเรียกว่า การทดสอบแบบหางเดียว ( One- tailed test 

) มี 2 กรณี คือ  

  กรณีหางเดียวทางขวาH1     : 1   >   2  

 

       ยอมรบั   oH                                                ปฎิเสธ  oH     

 

 

                                                                                              
 

 

  กรณีหางเดียวทางซ้าย H1     : 1   <   2  
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ปฎิเสธ  oH                                                  ยอมรบั   oH  

              

             
                                                                                                                                

 

 

2.2 แบบไม่มีทิศทาง หรือการทดสอบแบบสองหาง ( Two - tailed test ) ซ่ึงเปน็การทดสอบเมื่อ

H1     : 1       2  

                                      ยอมรบั oH     

ปฎิเสธ  oH                                                      ปฎิเสธ  oH                                                                 

                                                         

 

           
2

                                                              
2

                         

 

 

ขั้นที่ 3 คํานวณค่าสถิติทีใ่ช้ทดสอบสมมุติฐานทางคอมพิวเตอร์ 

ขั้นที่ 4 นําค่าสถิติทีไ่ด้จากคอมพิวเตอร ์(Sig.)ไปเปรียบเทียบกับค่าวิกฤต 

ขั้นที่ 5 การตดัสินใจ มี 2 กรณี 

 กรณีที่ 1 กรณีสองหาง สรุปผลดังน้ี   

1. ถ้าค่า Sig. <  จะปฏิเสธ (reject) H0 ยอมรบั (accept) H1    

2. ถ้าค่า Sig. >  จะยอมรับH0     

 กรณีที่ 2 กรณีหางเดียวทางขวาและกรณีหางเดียวทางซ้าย สรปุผลดังนี้   

1. ถ้าค่า Sig./2 <  จะปฏิเสธ (reject) H0 ยอมรบั (accept) H1    

2. ถ้าค่า Sig./2  >  จะยอมรบัH0     
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การประมวลผลข้อมูลด้วยคอมพิวเตอร์ : โปรแกรม SPSS for Windows 
 

 การประมวลผลข้อมูลเป็นการจัดการกับข้อมูลอย่างมีระบบ เพ่ือให้ขอมูลที่ได้รับการ

ประมวลผลแล้วอยู่ในรูปที่สามารถนําไปใช้งานได้อย่างมีประสิทธิภาพ  ซ่ึงมีข้ันตอน ดังนี้ 

 1 การเก็บรวบรวมข้อมูล เป็นการเก็บรวบรวมข้อมูลที่ได้จากรูปแบบต่างๆ เช่นแบบสอบถาม 

แบบทดสอบ แบบสัมภาษณ์ ทั้งที่เป็นข้อมูลปฐมภูมิและทุติยภูมิ 

 2. การเปล่ียนสภาพข้อมูล เป็นการเปลี่ยนสภาพของข้อมูลที่เกบ็รวบรวมมาได้ให้อยู่ในรูปแบบที่

สะดวกหรือเหมาะสมต่อการนําไปประมวลผล ซ่ึงประกอบด้วย 

  2.1 การลงรหัส (Coding) เป็นการเปล่ียนรูปแบบข้อมูลโดยให้รหัสแทนข้อมูลเพ่ือทําให้

สามารถจําแนกลักษณะข้อมูล รหัสที่ใช้แทนข้อมูลอาจจะอยู่ในรูปตัวเลข ตัวอักษร หรือข้อความ ซ่ึง

โดยปกตินิยมกําหนดรหัสข้อมูลให้เป็นตัวเลข (ยกเว้นโปรแกรมที่ใช้ประมวลผลข้อมูลในการวิจัยเชิง

คุณภาพโดยเฉพาะ) ไม่ว่าจะเป็นข้อมูลเชิงคุณภาพหรือเชิงปริมาณ แต่การนําไปวิเคราะห์หรือ

ประมวลผล และการตีความจะแตกต่างกันไป  

  2.2 การแก้ไข (Editing) เป็นการตรวจสอบความถูกต้องของข้อมูลรวมทั้งข้อมลูที่ได้

แปลงให้อยู่ในรูปรหัสแล้ว รวมทั้งการตรวจสอบความสมบูรณ์ของข้อมูล และแก้ไขปรับปรุงให้ถูกต้อง 

 3.  การประมวลผล (Data processing) เป็นการนําข้อมูลที่ได้จากการเปล่ียนสภาพแล้ว มาทํา

การวิเคราะห์ข้อมูล ซ่ึงในปจัจุบนัจะใช้โปรแกรมสําเร็จรูปทางสถิติช่วยในการวิเคราะห์ ซ่ึงการวิเคราะห์ 

อาจจะเปน็การวิเคราะห์ข้ันต้น เช่น การเรียงลําดับ (Sorting) การรวบรวมข้อมลู (Merging) หรือการ

วิเคราะห์ในระดับที่สูงขึ้นมาอีก เช่น การประมาณค่า (Estimate) การทดสอบสมมติฐาน (Hypothesis 

testing)  หรือการวิเคราะห์โดยใช้สถิติช้ันสูงอ่ืนๆ 

 4. การแสดงผลลัพธ์ (Output) เปน็การนําเสนอผลลัพธ์จากการวิเคราะห์ข้อมลูให้อยู่ในรูปที่

เข้าใจง่าย ซ่ึงอาจเป็นรายงาน ตาราง กราฟ หรือแผนภูมิอื่นๆ 

 

การสร้างรหัสสําหรับตัวแปร 

 โดยปกติในการวิจัย ผู้วิจัยจะออกแบบการวิจัยโดยกําหนดตัวแปรไว้ตั้งแต่ก่อนการเก็บรวบรวม

ข้อมูลแต่ถ้าเป็นข้อมูลที่มีการรวบรวมเพื่อประมวลผลเพื่อวัตถุประสงค์ใดประสงค์หนึง่อาจไม่ได้กําหนด

ตัวแปรไว้ล่วงหน้าก็ได้ ดังนั้นเมื่อมีการเก็บรวบรวมข้อมูลแล้ว จะต้องกําหนดตัวแปรหรือค่ารหัสของ

ตัวแปร การกําหนดชื่อตัวแปรนั้นจะต้องกําหนดทั้งข้อมูลที่เปน็เชิงคุณภาพและเชิงปริมาณ ส่วนการให้

ค่ารหัสนั้นมกัจะใช้กบัตัวแปรเชิงคุณภาพ เช่น เพศ อาชีพ ศาสนา วุฒิการศึกษา เป็นต้น ส่วนตัวแปรเชิง

ปริมาณก็ใช้ค่าที่ได้จากการเก็บรวบข้อมลูจริง เช่น อายุ ก็จะใส่ค่ารหัส ตามอายุจริงทีไ่ด้จากการเก็บ

รวบรวมข้อมลูมา ยกเว้น แต่มีการกําหนดช่วงอายุหรือจัดกลุ่มอายุไว้ตั้งแต่ก่อนการเกบ็ข้อมูล ใน

ลักษณะอย่างนี้จําเป็นต้องกําหนดค่ารหสัเช่นกนั 
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 ในบางครั้งการกําหนดตัวแปรหรือกําหนดรหัสจะทําควบคู่กับเครื่องมือการวิจัย ซ่ึงคําถาม 1 

คําถาม จะสามารถสร้างตัวแปรได้อย่างน้อย 1 ตัวแปร และค่าของตัวแปรทีไ่ด้ก็คือข้อมูลนัน่เอง 

สามารถแสดงตัวอย่างการกําหนดตัวแปรและการให้ค่ารหัสตัวแปรจากแบบสอบถาม ดังน้ี 
 

แบบสอบถามเพื่อการวิจัย หมายเลข...........

สําหรับเจ้าหน้าที ่

ตอนที่ 1 สถานภาพส่วนบุคคล 

            คําชี้แจง  กรุณากาเคร่ืองหมาย      ลงในช่อง �   ที่ตรงกับความเป็นจริงของ

ท่าน     

 

1. เพศ             �  1.ชาย                      �   2. หญิง 

2. อายุ.........................ปี 

3. ประสบการณ์ในการทํางาน........................ ปี 

4. ระดับการศึกษา 

       � 1.  ต่ํากว่าปริญญาตรี  � 2. ปริญญาตรี     �  3.ปริญญาโทขึ้นไป 

5. ขนาดโรงเรียนที่ทํางานอยูปั่จจุบัน 

       � 1. ขนาดเล็ก      �  2. ขนาดกลาง       �   3. ขนาดใหญ่   

 

 

 

 

SEX     � 

AGE    �� 

EXP     �� 

EDU    � 

 

SIZE   � 

 

 จากตัวอย่างแบบสอบถาม จะเห็นว่า ทางด้านขวามีช่ือตัวแปรกําหนดไว้ โดยการตัง้ชื่อตัวแปร

จะเปน็ภาษาไทยหรืออังกฤษก็ได้ การกําหนดชื่อตัวแปรที่จะใช้ประมวลผลด้วยคอมพิวเตอร์นั้นควร

กําหนดชื่อให้สอดคล้องกับตัวตัวแปรในการวิจยัในเรือ่งนั้นๆ ซ่ึงจะทําให้สะดวกต่อการจําและทําความ

เข้าใจ  ในกรณีที่ใช้โปรแกรม SPSS for Window จะมีความยาวไม่เกิน 8 ตวัอักษรซ่ึงจะกล่าวถึงใน

รายละเอียดต่อไป นอกจากนี้จะมีชองสี่เหล่ียมสําหรับใส่ค่ารหสัของตัวแปร ซ่ึงได้มาจากการตอบ

แบบสอบถาม ผู้วิจัยควรทาํสมุดคู่มือการกําหนดรหัสให้ตัวแปร โดยกําหนดชื่อตวัแปร ชนิดของตัวแปร 

ขนาดของตัวแปร และการให้ค่ารหัสตัวแปร 

 

ตัวอย่างการจัดทําคู่มือการลงรหสั 
 

คําถาม

ที่ 

ชื่อตัวแปร รายการ

ข้อมูล 

ขนาดตัว

แปร(จํานวน

หลัก) 

ค่ารหัส ข้อสังเกต 

1 SEX ช่ือ 1 1 ชาย 

2หญิง  

เลือกได้คําตอบ

เดียว 
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9ไม่ตอบ/ตอบสองข้อ 

2 AGE อายุ 2 ตามจริง

99 ไม่ตอบ 

อายุจริง 

3 EXP ประสบการ

ณ์ 

2 01 – 40 ตามจริง 

99  ไม่ตอบ 

ประสบการณ์

จริง 

4 EDU การศึกษา 1 1 ต่ํากว่าปริญญาตรี 

2 ปริญญาตรี 

3 ปริญญาโทขึ้นไป 

9ไม่ตอบ 

เลือกได้คําตอบ

เดียว 

5 SIZE ขนาด

โรงเรียน 

1 1 ขนาดเล็ก 

2ขนาดกลาง 

3ขนาดใหญ่ 

9ไม่ตอบ 

เลือกได้คําตอบ

เดียว 

 

 การจัดทําคู่มือลงรหัสจะทาํให้การลงข้อมูลได้ไม่ผิดพลาดโดยเฉพาะเมื่อตัวแปรมีจํานวนมาก  

อย่างไรก็ตามในบางครั้งจะนําข้อมูลที่ได้จากเครื่องมือการวิจยั ไปเขียนลงในกระดาษลงรหัส(Paper 

code) แล้วค่อยนําข้อมูลทีล่งรหัสในการกระดาษลงรหัสไปลงในโปรแกรมคอมพิวเตอร์ ในกรณีอาจจะ

เป็นการทําข้อมูลซ้ําซ้อนแต่จะสะดวกต่อการลงรหัสในโปรแกรม SPSS มากข้ึน และยังสะดวกต่อการ

ตรวจสอบในกรณีลงรหัสในโปรแกรมผิด เป็นประโยชน์ก็ได้ ซ่ึงในกระดาษลงรหัสนี้จะมีลักษณะคล้าย

กับหน้าต่าง Data editor ของ SPSS for window ซ่ึงจะประกอบด้วย หมายเลขแบบสอบถาม ตัวแปร และ

ค่ารหัสของตวัแปร ดังตัวอย่าง 
 

 

หมายเลข

แบบสอบถาม 

ตัวแปร (เท่ากับจํานวนข้อคําถามในเครื่องมือการวิจัย) 

SEX AGE EXP EDU SIZE ….

1 1 42 5 1 1 ….

2 1 35 7 1 1 ….

3 2 39 9 2 2 ….

4 1 48 10 3 3 ….

5 2 50 7 2 3 ….

. 

. 

. 

.

. 

. 

. 

. 

. 

.

. 

. 

.

. 

. 

. 

. 

. 

. 

. 

. 
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การใช้โปรแกรม SPSS for Windows 

 

โปรแกรม SPSS เปน็โปรแกรมทีใ่ช้ในการวิเคราะห์ข้อมูลทางสถิติทีไ่ด้รบัความนิยมอย่าง

แพร่หลายมานานตั้งแต่ ยงัใช้ เวอร์ชัน DOS จนกระทั่ง เวอร์ชันทีใ่ช้ใน Windows ได้มีการพัฒนาและ

ปรบัปรุงอยู่ตลอด โปรแกรม SPSS มีความสามารถมากมายแต่สําหรับการใช้โปรแกรม SPSS ในเนื้อหา

นี้จะพูดถึงส่วนที่จําเปน็และเกี่ยวข้องกบัการเรียนการสอนเท่านั้น  
 

การเปิด File หรือ การสรา้ง File ใหม่ 

 Start > Program > Spss ได้ดังภาพที่ 1 

 
ภาพที่ 1 

 

ในกรณีทีเ่รา กดปุ่ม Cancel เราจะได้ หน้าต่าง SPSS Data Editor ซ่ึงเป็นหน้าต่างสําหรบักรอก

และแก้ไขข้อมลู รวมทั้งการประมวลผลอื่นๆ 

ผลการเปิดโปรแกรมคร้ังแรก 
สามารถเปิด file เดิมท่ีมียู่
แลว้(เคยใชง้าน) หรือ click 

ท่ี cancel เพ่ือเปิดหรือสร้าง 
file ใหม่ 
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ภาพที่ 2 

 

ในกรณีทีต่้องการเปิด File ที่มีอยู่แล้วให้ Click ที ่File > Open > Data  หรือ Click ที ่   บน 

Tool Bar จะได้หน้าจอ ดังภาพที่ 3 หลังจากนั้นให้เลือก File ทีเราต้องการ และ Click ที่ Open  ในภาพ

เป็นการเปิด File ช่ือ Car 

 
ภาพที่ 3 

 

 

เปิด File ใหม่ : เลือก 
file ท่ีตอ้งการเปิด แลว้ 
click ท่ี open 

1 

2 
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ผลการเปิด File จะได้ดังภาพที่ 4 

 
ภาพที่ 4 

การกําหนดชื่อและค่าตัวแปร (Name) 

 อย่างไรก็ตาม ในกรณีทีเ่ปน็ File ยังไม่กรอกข้อมูล หรือ ยังไม่กําหนดชื่อและค่าตัวแปร ส่ิงที่เรา

ต้องทําก่อนวิเคราะห์ข้อมูล ก็คือ การกําหนดช่ือและค่าต่างๆให้ตัวแปร โดยการ Double Click ที่ Var จะ

ได้ผลดังภาพที่ 5  

 
ภาพที่ 5 
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 ในการกําหนดชื่อตัวแปรในโปรแกรม SPSS นั้นสามารถกําหนดได้ทั้งที่เป็น ภาษาไทยและ

ภาษาอังกฤษ แต่จะกําหนดได้เพียง 8 ตัวอักษร  และการกําหนดช่ือตัวแปรนั้นควรกําหนดให้สอดคล้อง

กับสภาพจริงของตัวแปร เช่น ตัวแปร เพศ ก็ควรกํา เพศ หรือ SEX  เปน็ต้น การกําหนดช่ือตัวแปรใน 

SPSS จะกําหนดได้ไม่เกิน 8 ตัวอักษร  
 

 

 
   ภาพที่ 6 

  

จากคู่มือลงรหัสจะพบว่าเพศได้กําหนดให้เป็น Sex และยังพบอีกว่ากําหนดให้ 1 แทนชาย และ 

2 แทนหญิง ดังนั้นในโปรแกรมจะต้องทาํการแทนเลขดังดังกล่าวด้วย โดยคลิกที ่  จะได้

ดังภาพที่ 7 

 
ภาพที่ 7 

Click แลว้พิมพช่ื์อตวัแปรซ่ึงในท่ีน้ีกาํหนดเป็น sex  
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กรอกค่าที่กําหนดให้กับตัวแปร ในทีนี้ตัวแปรเพศ กําหนดให ้เพศชาย เปน็ 1 และ เพศหญิงเป็น 

2    ข้ันตอนในกําหนดค่าฉลาก 

 1. พิมพ์ เลข 1  ลงในช่อง   Value 

 2. พิมพ์  male ลงในช่อง Value Label  (สามารถกรอกเปน็ภาษาไทยได้) 

 3. กดปุ่ม Add  

 ในกรณีกําหนดค่าให้เพศหญิง ทําเช่นเดียวกับ เพศชาย เพียงเปล่ียนจาก 1 เปน็ 2 และ

เปล่ียนจาก mail เป็น female  ส่วน ปุ่ม Change มีไว้สําหรับแก้ไข และถ้าต้องการลบออก ให้กด Remove  

 ส่วนตัวแปรตวัอื่นๆ ก็ทําเช่นเดียวกบัตัวแปร sex  

เมื่อกรอกชื่อตัวแปรครบทกุตัวแล้ว ก็จะได้ดังภาพที ่8 

 
ภาพที่ 8 

 

 

 

 

 

 

 

 

 

 

 

จากนั้นกท็ําการใส่ข้อมูลทีเ่ราเตรียมไว้สําหรับการวิเคราะห์ ก็จะได้ดังภาพที่ 9 

โดยปกติ ตัวแปรทีต้่องกาํหนดค่านี ้จะเป็นตัวแปรทีมี่ระดับการวดั 
เป็น Nominal หรือ Ordinal ส่วนตัวแปรทีมี่ระดับการวดัตั้งแต่ 

Interval ขึน้ไปมักไม่นิยมกาํหนดค่า 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๒๓ 
 

 
ภาพที่ 9 

 
 

การวิเคราะห์ข้อมูล (สถิติพรรณนา)  

การหาค่าความถี่และร้อยละ (ข้อมูลเชิงคุณภาพ) 

 เปิดโปรแกรม Spss > เปิดไฟล์ที่ต้องการวิเคราะห์ (สมมุติข้อมูลข้างต้น) จะได้ภาพที่ 10 

 
ภาพที่ 10 

 

จากนั้นคลิก Analyze > Descriptive Statistics > Frequencies ดังภาพที่ 11 
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   ภาพที่ 11 

จากภาพที ่11 จะได้ภาพที่ 12 ดังนี้ 
 

 

 

 

 

 
  ภาพที่ 12  

 

 

 

จะได้ผลลัพธ์ดังภาพที่ 13 

1. เลือกตวัแปรท่ีตอ้งการหาค่าความถ่ี
และร้อยละ ซ่ึงในท่ีน้ีตอ้งการหาความถ่ี
ของ sex  

2 กด OK 
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ภาพที่ 13 

 

 

ตัวอย่างการนําเสนอผลการวิเคราะห์ข้อมูลและการแปลผล 

ตารางที่ 1 แสดงจํานวนและร้อยละของข้อมูลส่วนบุคคลของกลุ่มตัวอย่าง  

ข้อมูลส่วนบคุคล (n=100) จํานวน ร้อยละ 

เพศ 

     ชาย 

     หญิง 

ศาสนา 

     พุทธ 

     คริสต์ 

     อิสลาม 

75 

25 

 

60 

30 

10 

 

75.0 

25.0 

 

60.0 

30.0 

10.0 

 

จากตารางที่ 1 พบว่า กลุ่มตัวอย่างจํานวน 100 คน ส่วนใหญ่เปน็เพศชายมากที่สุด ร้อยละ 75.0 

ส่วนศาสนากลุ่มตัวอย่างนบัถือศาสนาพุทธมากที่สุด ร้อยละ 60.0 รองลงมานบัถือศาสนาคริสต์ ร้อย

ละ 30.0   
 

 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๒๖ 
 

การหาค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน (ข้อมูลเชิงปริมาณ) 

 เปิดโปรแกรม Spss > เปิดไฟล์ที่ต้องการวิเคราะห์ (สมมุติข้อมูลข้างต้น) จะได้ภาพที่ 14 

 
ภาพที่ 14 

 

จากนั้นคลิก Analyze > Descriptive Statistics > Descriptive ดังภาพที่ 15 

 
ภาพที่ 15 

จากภาพที ่15 จะได้ภาพที่ 16 ดังนี้ 
1. เลือกตวัแปรท่ีตอ้งการหาค่าเฉล่ียและ
ค่าเบ่ียงเบนมาตรฐาน ซ่ึงในท่ีน้ีตอ้งการ
หาค่าของ age  
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   ภาพที่ 16 

 

จะได้ผลลัพธ์ดังภาพที่ 17 

 
 

ภาพที่ 17 

 

 

 

 

 

ตัวอย่างการนําเสนอผลการวิเคราะห์ข้อมูลและการแปลผล 

2 กด OK 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๒๘ 
 

ตาราง 2 แสดง อายุ รายได้ต่อเดือนของกลุ่มตัวอย่าง 

ตัวแปร ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน 

อายุ 35.5 12.0 

รายได้ 6750.57 38.75 

 

 จากตาราง 2 พบว่า กลุ่มตัวอย่างมีอายุเฉล่ีย 35.5 ป ีมีรายได้เฉล่ียเดือนละ 6750.57 บาท 
 

 

การวิเคราะห์ข้อมูล (สถิติอนุมาน)  
 

การทดสอบ t-test 

 กระบวนการทางสถิติ t-test เปน็การแจกแจกแบบ Student’s สําหรบัเปรียบเทียบค่าเฉล่ีย 2 ค่า 

นอกจากนั้นยงัแสดงค่าเฉลีย่ ส่วนเบี่ยงเบนมาตรฐานและความคลาดเคลื่อนมาตรฐานในแต่ละตัวแปร

ด้วย ซ่ึงสถิติ t-test สามารถแบ่งการวิเคราะห์ได้เป็น 2 กรณี 

 กรณีที่ 1 กลุ่มตัวอย่างทั้ง 2 ไม่สัมพันธ์กัน (อิสระต่อกัน) เรียกว่า Independent t-test 

 ถ้ากลุ่มตัวอย่างทั้ง 2 ไม่สัมพันธ์กัน (อิสระต่อกนั) ในการทดสอบสมมุติฐานที่ต้องการหาความ

แตกต่างของค่าเฉล่ียของกลุ่มตัวอย่างกลุ่มหนึง่ว่าแตกต่างจากอีกกลุ่มหนึ่งหรือไม่ เช่น ต้องการทดสอบ

ผลสัมฤทธิ์ทางการเรียนของกลุ่มที่ได้รับการสอนแบบปกติกับกลุ่มที่ได้รับการสอนแบบพิเศษว่าจะมี

คะแนนเฉลี่ยแตกต่างจากกันหรือไม่ ในกรณีนี้กลุ่มตัวอย่างสองกลุ่มเป็นอิสระจากกัน เราสามารถตั้ง

สมมุติฐานได้ดังนี้ 

  สมมุติฐาน 1 210 :H   

    211 :H   หรือ 

  สมมุติฐาน 2 210 :H   

    211 :H   หรือ 

  สมมุติฐาน 3 210 :H   

    211 :H   

  สูตรคํานวณ 

  ข้ันแรก คํานวณหาว่ากลุ่มตัวอย่างทั้งสองกลุ่มมีความแปรปรวนแตกต่างกันหรือไม่ 

ด้วยสูตร F-test มีสมมุติฐานดังนี้ 

 

    2
2

2
10 :H   



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๒๙ 
 

    2
2

2
11 :H   

   คํานวณด้วยสูตร 

    1ndf;1ndf;
S

S
F 22112

2

2
1   

  พิจารณาค่า F-test ถ้า F-test ที่คํานวณได้ไม่มีนัยสําคัญทางสถิติ (Sig >  ) นั่นคือ

ยอมรบั H0 แสดงว่าความแปรปรวนของทั้งสองกลุ่มเท่ากัน จะใช้สูตรที่ 1 (Pooled Variance) ถ้าค่า F-

test ที่คํานวณได้มีนัยสําคัญทางสถิติ (Sig <  ) นัน่คือปฏิเสธ H0 ยอมรบั H1 แสดงว่าความแปรปรวน

ของทั้งสองกลุ่มไม่เท่ากัน จะใช้สูตรที ่2  แทน (Separate Variance) 

   

ข้ันที่สอง เลือกใช้สูตรคํานวณค่า t-test 

   สูตรที่ 1 เมื่อ 2
2

2
1   
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   สูตรที่ 2 เมื่อ 2
2

2
1   

    

2

2
2

1

2
1

21

n
S

n
S
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t




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2

2

2
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2
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1

2

2
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2
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1
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
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









  

 

การพิจารณาหากค่าสถิติ t ที่คํานวณได้ไม่มีนัยสําคัญทางสถิติ (Sig >  ) นั่นคือ

ยอมรบั H0 แสดงว่าค่าเฉลีย่ของ 2 กลุ่มไม่มีความแตกต่างกัน ถ้าค่า t ที่คํานวณได้มีนยัสําคัญทางสถิติ 

(Sig <  ) นั่นคือปฏิเสธ H0 ยอมรบั H1 แสดงว่ามีค่าเฉล่ียของ 2 กลุ่มแตกต่างกัน (มากกว่า หรือน้อย

กว่า) 

 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๓๐ 
 

ขั้นตอนการทดสอบ t-test  แบบกลุ่มตัวอย่างเป็นอิสระจากกัน 

 

เปิดโปรแกรม SPSS 

Analyze  > Compare Means > Independent-Sample T Test ดังภาพที่ 18 

 
 

 
ภาพที่ 18 

 

 

 

 

 

 

 

 

ผลจะได้ หน้าต่าง Independent Sample T test หลังจากนั้นให้ทําตามข้ันที ่1 ถึง ข้ันตอนที่ 8 ดังภาพที่ 

19 
 
 


  

1.เลือกตวัแปรท่ีตอ้งการ
ทดสอบ 

3. ช่องสาํหรับตวัแปรตามท่ีตอ้งการทดสอบ 
(ขอ้มูลเชิงปริมาณ) สามารถใส่ไดม้ากกวา่หน่ึงตวั
แปร 
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ภาพที1่9 

 

ผลการวิเคราะห์ข้อมูลจะได้ หน้าต่างที่เรียกว่า SPSS Viewer ดังภาพที่ 20  
 

2. click 

4.ช่องสาํหรับตวัแปรอิสระ 
(ขอ้มูลเชิงคุณภาพ: 2 กลุ่ม) ซ่ึงตอ้ง
เลือกมาจากช่องตวัแปรดา้นซา้ย 
เม่ือเลือกแลว้ใหก้ดปุ่ม 5 

5. Click 

6.กาํหนดกลุ่ม เพ่ือเป็น
ระบุกลุ่มท่ีตอ้งการ
เปรียบ 

7.ใส่ค่าของตวัแปรลงไป ในท่ีน้ี 1 หมายถึง 
เพศชาย 2 หมายถึงเพศหญิง หลงัจากนั้น 
click ปุ่ม Continue 

8. Click ปุ่ม OK 

ภาพประกอบ 16 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๓๒ 
 

 
ภาพที่ 20 

 
จากตารางเปน็การแสดงสถิติพรรณนา (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) โดยที่ตัวแปร 

EANIETY ของเพศชายมีค่าเฉลี่ย 2.82 และของเพศหญิงมีค่าเฉล่ีย 3.72 เปน็ต้น 

 

ตวัแปรตาม ตวัแปรอิสระ 
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การทดสอบความเท่ากนัของความแปรปรวน โดยใช้ F –test  การพิจารณาว่าความ

แปรปรวนเท่ากันหรือไม่ให้ดูได้จากช่อง Sig (หมายถึงระดับนัยสําคัญทางสถิติ)  ถ้าค่า Sig > 0.05 แสดง

ว่า ความแปรปรวนเท่ากนั แต่ถ้า Sig < 0.05  แสดงว่า ความแปรปรวนแตกต่างกนัอย่างมีนัยสําคัญทาง

สถิต ิ

 ผลการทดสอบสมมติฐานด้วย t-test จะเหน็ว่า ค่า t มี 2 ค่า จะใช้ค่าใดข้ึนอยู่กับผลการ

ทดสอบความเท่ากนัของความแปรปรวน ถ้า F-test ไม่มีนัยสําคัญทางสถิติ (Sig > 0.05) ให้ใช้ค่าบน   

แต่ถ้ามีนยัสําคัญทางสถิติ (Sig < 0.05) ให้ใช้ค่าล่าง จากตาราง ในกรณีตัวแปร EANXIETY พบว่า ค่า F 

ไม่มีนัยสําคัญทางสถิติ (Sig > 0.05) แสดงว่าความแปรปรวนเท่ากนั ค่า t ที่ใช้ คือ -5.393 ,df=88 และ 

sig = .000 (sig < 0.05) ซ่ึงหมายความว่า ครูอาจารย์ทีม่ีเพศต่างกันมีความวิตกกงัวลในเหตุการณ์

แตกต่างกันอย่างมีนัยสําคัญทางสถิติทีร่ะดับ 0.05 ส่วนตัวแปร PERFOM ก็อ่านค่าในลักษณะเดียวกัน 

 

ตัวอย่างที่ 1 นักเรียนในกรงุเทพฯจะมีทศันะคติทางวิทยาศาสตร์ดีกว่านักเรียนในชนบท 

จากตัวอย่างที่ 1 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ภมิูลําเนาของนักเรียน (กรุงเทพฯ และชนบท) 

2) ทัศนะคติทางวิทยาศาสตร์ (วัดออกมาเป็นตัวเลข) 

คนที่ ภูมิลําเนาของนักเรียน ทัศนะคติทางวิทยาศาสตร ์

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

กรุงเทพ

กรุงเทพ  

ชนบท 

กรุงเทพ  

ชนบท 

กรุงเทพ  

ชนบท 

ชนบท 

ชนบท 

กรุงเทพ  

กรุงเทพ  

ชนบท 

กรุงเทพ  

ชนบท 

กรุงเทพ  

ชนบท 

ชนบท 

4 

2 

1 

5 

3 

2 

4 

2 

1 

3 

5 

4 

2 

3 

5 

5 

2 

 
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คนที่ ภูมิลําเนาของนักเรียน ทัศนะคติทางวิทยาศาสตร ์

18 

19 

20 

กรุงเทพ

กรุงเทพ  

ชนบท 

2 

1 

3 

 

 การตั้งสมมุติฐาน H0    :  1   =   2  

   H1     :  1     2  

 โดยที ่ 1 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในกรุงเทพ 

  2 คือ ค่าเฉลี่ยของทัศนะคติทางวิทยาศาสตร์ของนักเรียนในชนบท 

 สถิติทีจ่ะใช้ในการทดสอบ คือ Independent t-test 

 

ข้ันตอนการวิเคราะห์ 

 เปิดโปรแกรม Spss จะได้ภาพที่ 21 

 
ภาพที่ 21 
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 ทําการกําหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามข้ันตอนข้างต้น) ดังภาพที่ 22

 
ภาพที่ 22 
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คลิก Analyze  > Compare Means > Independent-Sample T Test ดังภาพที่ 23 

 
ภาพที่ 23 

 

จะได้หน้าจอดังภาพที่ 24 ทําการใส่ตัวแปรที่ต้องการวิเคราะห ์ 

 ในช่อง Test Variable เลือกตัวแปร att 

 ในช่อง Grouping Variable เลือกตัวแปร add แล้วคลิก  เพื่อกําหนดกลุ่ม 

โดยที ่ Group 1 ให้ใส่เลข 1 หมายถึงกลุ่มกรุงเทพ 

 Group 2 ให้ใส่เลข 2 หมายถึงกลุ่มชนบท  

คลิก Continue 

 แล้วคลิก OK  
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ภาพที่ 24 

 

ผลการวิเคราะห์จะได้ดังภาพที่  

 

  

ตารางนี้แสดงค่าสถิติพื้นฐาน (ค่าเฉลีย่และค่าเบี่ยงเบนมาตรฐาน) พบว่า ค่าเฉลี่ยทัศนคติทาง

วิทยาศาสตร์ของนักเรียนกรุงเทพมีค่า 3.10 ส่วนของนกัเรียนชนบนมีค่า 2.80 

Group Statistics

10 3.1000 1.5239 .4819

10 2.8000 1.3166 .4163

add
bankok

countryside

ATT
N Mean

Std.
Deviation

Std. Error
Mean
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จากตารางจะแบ่งการทดสอบเปน็ 2 กรณี  

กรณีที่ 1 เป็นการทดสอบความแปรปรวนโดยใช้สถิติ F-test ซ่ึงมีสมมตุิฐานดังน้ี 
2
2

2
10 :H   

    2
2

2
11 :H   

พบว่า ค่าสถิติ F-test = 0.845 และค่า Sig = 0.368 ซ่ึงมากกว่า 0.05 ดังนั้นจึงสรุปว่า ยอมรบั

สมมุติฐาน H0 ดังนั้นสรปุว่า ความแปรปรวนของทั้งสองกลุ่มเท่ากนักนั 

 

กรณีที่ 2 เปน็การทดสอบค่าเฉลี่ย โดยใช้สถิติ t-test ซ่ึงมีสมมติฐาน ดังนี้ 

    210 :H   

    211 :H   

พบว่า ค่าสถิติ t-test = 0.471 และค่า Sig = 0.643 (2-tailed) แต่เราต้องการทดสอบทางเดียว

ดังนั้นค่า Sig = 0.643/2 = 0.3215 (1-tailed) ซ่ึงมากกว่า 0.05 ดังนั้นจึงสรปุว่ายอมรบัสมมตุิฐาน H0 

ดังนั้นสรุปว่า 210 :H  หมายความว่านกัเรียนในกรุงเทพฯจะมีทัศนะคติทางวิทยาศาสตร์ที่

เท่ากับ (ไม่แตกต่าง) กับนักเรียนในชนบท 

 

การนําเสนอผลการวิเคราะห์ด้วย Independent t-test 

ตารางที่ 3 แสดงการเปรียบเทียบทัศนคติทางวิทยาศาสตร์ของนักเรียนในกรุงเทพและชนบท 

เพศ จํานวน ค่าเฉลี่ย ค่าเบี่ยงเบน

มาตรฐาน 

ค่า t Sig. 

กรุงเทพ 

ชนบท 

10

10 

3.10

2.80 

1.52

1.31 

0.471 0.322 

* P<0.05 

จากการทดสอบ พบว่า นกัเรียนในกรงุเทพฯ และในชนบทจะมีทัศนะคติทางวิทยาศาสตร์ที่ไม่

แตกต่างกันอย่างมีนยัสําคัญทางสถิติที่ 0.05 

 

Independent Samples Test

.854 .368 .471 18 .643 .3000 .6368 -1.0379 1.6379

.471 17.628 .643 .3000 .6368 -1.0400 1.6400

Equal variances
assumed

Equal variances
not assumed

ATT
F Sig.

Levene's Test for
Equality of Variances

t df
Sig.

(2-tailed)
Mean

Difference
Std. Error
Difference Lower Upper

95% Confidence
Interval of the

Difference

t-test for Equality of Means
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กรณีที่ 2 กลุ่มตัวอย่างทั้ง 2 สัมพันธ์กัน เรียกว่า Pair t-test  

 ถ้ากลุ่มตัวอย่างทั้ง 2 สัมพันธ์กัน ในการเปรียบเทียบค่าเฉล่ียสองค่าว่าแตกต่างกนัหรือไม่ โดย

ค่าเฉลี่ยทั้งสองค่านี้วัดมาจากกลุ่มตัวอย่าง 2 กลุ่มทีสั่มพันธ์กัน โดยอาจจะวัดมาจากกลุ่มตวัอย่างกลุ่ม

เดียวกัน 2 ครั้ง หรือวัดมากจากกลุ่มตัวอย่าง 2 กลุ่มที่ได้มาจากการจับคู่คุณลักษณะที่เท่าเทียมกัน มี

วิธีการคํานวณหาความแตกต่างของค่าเฉลี่ย ดังน้ี 

ลักษณะการตั้งสมมตุิฐาน  H0     : ก่อน     =   หลงั  

    H1     :  ก่อน       หลงั  หรือ 

    H0     : ก่อน     =   หลงั  

    H1     :  ก่อน   >   หลงั  หรือ 

H0     : ก่อน     =   หลงั  

    H1     :  ก่อน   <   หลงั  

    

  สูตรคํานวณ 

   
1n

)dd(
Sและ

n
d

dโดยท่ี

n
S
d

t dd 


 
 

   1ndf   
 

การพิจารณาหากค่าสถิติ t ที่คํานวณได้ไม่มีนัยสําคัญทางสถิติ (Sig >  ) นั่นคือยอมรับ H0 

แสดงว่าค่าเฉลี่ยก่อนและหลังไม่มีความแตกต่างกัน ถ้าค่า t ที่คํานวณได้มีนัยสําคัญทางสถิติ (Sig < 
) นัน่คือปฏิเสธ H0 ยอมรบั H1 แสดงว่ามีค่าเฉลี่ยก่อนและหลังแตกต่างกนั (ก่อนมากกว่าหลัง หรือก่อน

น้อยกว่าหลัง) 
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ขั้นตอนการทดสอบ t-test  แบบกลุ่มตัวอย่างที่สัมพันธ์กัน 

 

เปิดโปรแกรม SPSS 

Analyze  > Compare Means > Paired-Sample T Test ดังภาพที ่25 

 

 

 
ภาพที่ 25 

 

 

 

 

 

 

 

 

 

 

 

 

   
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ผลจะได้ หน้าต่าง Paired Sample T test ดังภาพที่ 26 

 

 

 

 

 
ภาพที่ 26 

 

 

 

ต่อมาคลิก  จะได้ภาพที่ 27 แล้วคลิก OK 

 
ภาพที่ 27 

 

 

 

1 เลือกตวัแปร before 

2 เลือกตวัแปร after 

3 ตวัแปร before และ 
after จะปรากฏในช่องน้ี 

 Click ปุ่ม OK 
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ผลการวิเคราะห์ข้อมูลจะได้ดังภาพที ่28 

 
 

ภาพที่ 28 

T-Test 
 

 
 

จากตารางเปน็การแสดงสถิติพรรณนา (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) โดยที่ตัวแปร 

BEFORE มีค่าเฉลี่ย 6.10 และ AFTER มีค่าเฉลี่ย 5.86  

 
 

 
 

 จากตารางแสดงความสัมพันธ์ระหว่างตัวแปร BEFORE และ AFTER ซ่ึงมีความสัมพันธ์ 0.197 

แต่ว่าไม่มีความสัมพันธ์กัน (Sig > 0.05) 
 

Paired Samples Statistics

6.1600 50 1.6081 .2274

5.8600 50 1.9379 .2741

BEFORE

AFTER

Pair
1

Mean N
Std.

Deviation
Std. Error

Mean

Paired Samples Correlations

50 .197 .170BEFORE & AFTERPair 1
N Correlation Sig.
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ผลการทดสอบสมมติฐานด้วย t-test จะเห็นว่า ค่า t คือ 0.938 ,df=49 และ sig = .353 (sig > 

0.05) ซ่ึงหมายความว่า ก่อนและหลังการทดสอบไม่มีความแตกต่างกันอย่างมีนยัสําคัญทางสถิติที ่

0.05 

 

ตัวอย่างที่ 2 ผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังเข้าค่ายของนักศึกษา 

จากตัวอย่างที่ 2 มีตัวแปรที่เกี่ยวข้อง 2 ตัวคือ 1) ผลการเรียนรู้ก่อนเข้าค่าย (วัดออกมาเปน็

ตัวเลข) 2) ผลการเรียนรูห้ลังเข้าค่าย (วัดออกมาเปน็ตัวเลข) 

 

คนที่ ผลการเรียนรู้ก่อนเข้าค่าย ผลการเรียนรู้หลังเข้าค่าย 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

4.00

8.00 

5.00 

4.00 

3.00 

5.00 

5.00 

4.00 

8.00 

4.00 

7.00 

5.00 

4.00 

3.00 

2.00 

6.00 

2.00 

5.00 

8.00 

4.00 

4.00 

8.00 

7.00 

5.00 

6.00 

3.00 

2.00 

5.00 

8.00 

7.00 

9.00 

6.00 

5.00 

8.00 

4.00 

5.00 

7.00 

8.00 

5.00 

6.00 

Paired Samples Test

.3000 2.2610 .3198 -.3426 .9426 .938 49 .353BEFORE - AFTERPair 1
Mean

Std.
Deviation

Std. Error
Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df
Sig.

(2-tailed)
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การตั้งสมมุติฐาน H0     : ก่อน     =   หลงั  

   H1     :  ก่อน   <   หลงั  

 โดยที ่ ก่อนคือ ค่าเฉลี่ยของผลการเรียนรู้ก่อนเข้าค่ายของนักศึกษา 

หลงัคือ ค่าเฉลี่ยของผลการเรียนรู้หลังเข้าค่ายของนักศึกษา 

 สถิติทีจ่ะใช้ในการทดสอบ คือ Pair t-test 

 

ข้ันตอนการวิเคราะห์ 

 เปิดโปรแกรม Spss จะได้ภาพที่ 29 

 
ภาพที่ 29 

 

 ทําการกําหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามข้ันตอนข้างต้น) ดังภาพที่ 30 
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ภาพที่ 30 

 

 

คลิก Analyze  > Compare Means > Paired-Sample T Test ดังภาพที ่31 
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ภาพที่ 31 

 

 

จะได้หน้าจอดังภาพที่ 32 ทําการเลือกตัวแปรที่ต้องการวิเคราะห์ ในทีน่ี้เลือก before และ after  

แล้วคลิด OK 

 
ภาพที่ 32 
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ผลการวิเคราะห์จะได้ดังน้ี 

 

T-Test 

 

 
 

จากตารางเปน็การแสดงสถิติพรรณนา (ค่าเฉลี่ยและค่าเบี่ยงเบนมาตรฐาน) โดยที่ตัวแปร 

BEFORE มีค่าเฉลี่ย 4.80 และ AFTER มีค่าเฉลี่ย 5.90  

 

 
 

 จากตารางแสดงความสัมพันธ์ระหว่างตัวแปร BEFORE และ AFTER ซ่ึงมีความสัมพันธ์ 0.257 

แต่ว่าไม่มีความสัมพันธ์กัน (Sig > 0.05) 

 

 
 

 จากตารางเปน็การทดสอบสมมุติฐาน ดังนี้ 

  H0     : ก่อน     =   หลงั  

  H1     :  ก่อน   <   หลงั  

ผลการทดสอบสมมติฐานด้วย t-test จะเห็นว่า ค่า t คือ -2.191 ,df=19 และ sig = 0.041(2-

tailed) แต่เราต้องการทดสอบทางเดียว ดังนั้นค่า sig = 0.041/2=0.0205 (1-tailed) ซ่ึงน้อยกว่า 0.05

ดังนั้นจึงปฎิเศษสมมุติฐาน H0 ยอมรบัสมมตุิฐาน H1 คือ H1     :  ก่อน   <   หลงั ซ่ึงหมายความว่า 

Paired Samples Statistics

4.8000 20 1.8238 .4078

5.9000 20 1.8610 .4161

BEFORE

AFTER

Pair
1

Mean N
Std.

Deviation
Std. Error

Mean

Paired Samples Correlations

20 .257 .273BEFORE & AFTERPair 1
N Correlation Sig.

Paired Samples Test

-1.1000 2.2455 .5021 -2.1509 -4.91E-02 -2.191 19 .041BEFORE - AFTERPair 1
Mean

Std.
Deviation

Std. Error
Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df
Sig.

(2-tailed)
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ผลการเรียนรู้ก่อนการเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลังการเข้าค่ายของนักศึกษาอย่างมี

นัยสําคัญทางสถิติที ่0.05 

 

การนําเสนอผลการวิเคราะห์ด้วย Paired t-test 

ตารางที่ 4  แสดงการเปรียบเทียบผลการเรียนรู้ก่อนและหลังการเข้าค่ายของนักเรียน 

การเรียนรู้ จํานวน ค่าเฉลี่ย ค่าเบี่ยงเบน

มาตรฐาน 

ค่า t Sig. 

ก่อน 

หลัง 

20

20 

4.80

5.90 

1.82

1.86 

-2.191* 0.021 

* P<0.05 

จากการทดสอบ พบว่า ผลการเรียนรู้ก่อนการเข้าค่ายของนักศึกษาน้อยกว่าผลการเรียนรู้หลัง

การเข้าค่ายของนักศึกษาอย่างมีนัยสําคัญทางสถิติที ่0.05 
 

 

การวิเคราะห์ความแปรปรวนทางเดียว  One - way ANOVA 

การวิเคราะห์ความแปรปรวนแบบทางเดียว (One-way ANOVA) เปน็การทดสอบความแตกต่าง

ของประชากรที่มีลักษณะทีส่นใจลักษณะเดียวแต่มีข้อมูลจากหลายประชากร  

จากความหมายดังกล่าวอาจกล่าวได้ว่าเป็นการทดสอบความแตกต่างระหว่างค่าเฉลี่ยของ

ประชากรตั้งแต่สองประชากรข้ึนไปที่มีลักษณะทีต่้องการทดสอบเพียงลักษณะเดียว เช่น การทดสอบ

ระหว่างคะแนนเฉล่ียของนกัเรียนที่สอบคัดเลือกเข้ามหาวิทยาลัย 4 โรงเรียน ว่ามีความแตกต่างกนั

หรือไม่ เป็นต้น ซ่ึงตัวแปรทีใ่ช้ในการวิเคราะห์ ตัวแปรตามจะต้องมีระดับการวัดอยู่ในระดับอันตรภาค 

(Interval scale) ข้ึนไป ส่วนตัวแปรอิสระจะมีเพียงตวัเดียวและต้องอยู่ในระดับนามบัญญัติ (Nominal 

scale) ซ่ึงจะแบ่งออกเป็น k ระดับ 

ส่วนการทดสอบจะใช้สถิติ F-test ในการทดสอบ ซ่ึงลักษณะการตั้งสมมตุิฐานจะเป็นดังนี้  

  k3210 ......:H   

  กนัคู่แตกต่าง1อยา่งนอ้ยค่า:H1   

 สถิติทีใ่ช้ทดสอบ 

  knและ1kdf
MS
MS

F
w

b   
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สามารถเขียนเป็นตารางวิเคราะห์ความแปรปรวน ได้ดังนี้ 

แหล่งความแปรปรวน SS df MS F 

Between  

Within 

SSb

SSw 

k-1

n-k 

MSb

MSw MSw
MSb

 

Total SSt n-1  

 

  

 

การพิจารณาหากค่าสถิติ F ที่คํานวณได้ไม่มีนัยสําคัญทางสถิติ (Sig >  ) นั่นคือยอมรับ H0 

แสดงว่าค่าเฉลี่ยของกลุ่มไม่มีความแตกต่างกนั ถ้าค่า F ที่คํานวณได้มีนัยสําคัญทางสถิติ (Sig <  ) นั่น

คือปฏิเสธ H0 ยอมรบั H1 แสดงว่ามีค่าเฉล่ียอย่างน้อย 1 คู่ที่แตกต่างกัน หากต้องการทราบว่าคู่ใดบ้างที่

แตกต่างกันให้ดําเนินการเปรียบเทียบต่อไป ซ่ึงก็มีวิธีเปรียบเทียบหลายวิธีดังนี้ 

 1. วิธี Lease significance difference 

 2. วิธี Duncan’s multiple-range test 

 3. วิธี Student-Newman-Keuls test 

 4. วิธี Turkey’s alternate test 

 5. วิธี Scheffe’s test เป็นตน้ 

 

ขั้นตอนการทดสอบ ANOVA 

 

เปิดโปรแกรม SPSS 

Analyze > Compare Means > One-way ANOVA  ดังภาพที่ 33 
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ภาพที่ 33 

 

 

 หลังจากนั้นให้ทาตามข้ันตอน ดังภาพที่ 34-36 
 

 

 

 
 

 



1.เลือกตวัแปรอิสระและตวัแปรตาม 
2.ช่องสาํหรับตวัแปรตามท่ี
ตอ้งการทดสอบ (ขอ้มูลเชิง
ประมาณ) 

3.ตวัแปรอิสระ (ขอ้มูลเชิง
คุณภาพ: 2 กลุ่มขั้นไป) 

4. Click  ปุ่ม Option เพ่ือ
กาํหนดค่าสถิติเพ่ิมเติม 
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ภาพที่ 34 
 

 

 

 

 
ภาพที่ 35 

 

 

5. ผลท่ีไดจ้ากการ Click 
ปุ่ม option ให ้check ท่ี 
descriptive เพ่ือให้
คาํนวณค่าสถิติบรรยาย 

6. Click ปุ่ม Post Hoc เพ่ือเลือกวิธีเปรียบเทียบพหุคูณ (multiple comparison) ซ่ึงสามารถ
เลือกไดห้ลายวธีิ แต่เวลานาํเสนอผลการวเิคราะห์ ใหน้าํเสนอเพียงวธีิเดียว ในท่ีน้ีเลือก 
LSD กบั Scheffe   

7. Clickปุ่ม Continue 
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ภาพที่ 36 

 

 

ผลที่ได้จากการใช้คําส่ัง   One way ANOVA 

 
 

                                        

จากตาราง ANOVA 

 1. ตัวแปร Anxiety : พบว่า ค่า F = .435 sig = .649 (>0.05) ซ่ึงแสดงว่า ครูอาจารย์ที่อยู่ใน

โรงเรียนขนาดการต่างกัน  มีความวิตกกังวลในการทาํงานไม่แตกต่างกัน 

 2. ตัวแปร Eanxiety : พบว่า ค่า F = .723 sig = .488 (>0.05) แสดงว่า ว่า ครอูาจารย์ที่อยูใ่น

โรงเรียนขนาดการต่างกัน  มีความวิตกกังวลในเหตุการณ์ไม่แตกต่างหัน  

8. กดปุ่ม OK 

 

 
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 ซ่ึงถ้าผลการวิเคราะห์ออกมาเช่นนี้ ไม่จาํเป็นต้องไปดู ผลการเปรียบเทียบพหุคูณ เพราะการ

ทดสอบโดยภาพรวมไม่มีคู่ใดแตกต่างกัน 

 แต่ถ้าผลการวิเคราะห์ออกมาว่ามีค่าทีไ่ม่เท่ากัน 1 คู่ เราต้องการการทดสอบต่อไปว่าคู่ใด

แตกต่างกัน ซ่ึงผลออกจะจะได้ดังภาพที่  
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ตัวอย่างที่ 3 นักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีการต่างกนัจะมีวินัยในตนเองต่างกัน 

จากตัวอย่างที่ 3 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) วิธีการอบรมเลี้ยงดู (มีหลายวิธี) 2) วินัยใน

ตนเอง (วัดออกมาเปน็ตัวเลข) 

 

คนที่ วธิีการอบรมเลี้ยงดู วนัิยในตนเอง 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

1

2 

3 

1 

2 

3 

1 

2 

3 

1 

2 

3 

1 

2 

3 

1 

2 

3 

1 

2 

4 

1 

4 

5 

1 

5 

5 

1 

5 

3 

5 

4 

1 

3 

5 

5 

1 

5 

1 

1 

 

การตั้งสมมุติฐาน H0     : 1   =   2   =  3  

   H1     : 1      2      3   

หรือ มีค่า  อย่างน้อย 1 คู่ทีไ่ม่เท่ากัน 

 โดยที ่ 1 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีที ่1 

  2 คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีที ่2 

3คือ ค่าเฉลี่ยของวินัยในตนเองของนักเรียนทีไ่ด้รบัการอบรมเล้ียงดูด้วยวิธีที ่3 

 สถิติทีจ่ะใช้ในการทดสอบ คือ ANOVA 
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ข้ันตอนการวิเคราะห์ 

 เปิดโปรแกรม Spss จะได้ภาพที่ 37 

 
ภาพที่ 37 

 

 

 ทําการกําหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามข้ันตอนข้างต้น) จะได้ภาพที่ 38 
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ภาพที่ 38 
 

คลิก Analyze > Compare Means > One-way ANOVA  ดังภาพที ่39 
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ภาพที่ 39 

 

จะได้หน้าจอดังภาพที่ 40 ทําการใส่ตัวแปรที่ต้องการวิเคราะห์  

 ในช่อง Dependent Variable เลือกตัวแปร discip 

 ในช่อง Factor เลือกตัวแปร care 

 
ภาพที่ 40 

 

ถ้าต้องการแสดงสถิติพื้นฐานคลิกที่  แล้วคลิกที่ Descriptive ดังภาพที่ 41 
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 ภาพที่ 41 

 

 ถ้าต้องการเปรียบเทียบคู่ทีแ่ตกต่างกันให้คลิก  แล้วคลิกที่วิธี LSD ดังภาพที ่42 

 
ภาพที่ 42 

 

 แล้วกด OK  ผลการวิเคราะห์ดังนี้ 
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Oneway 
 

 
 

จากตารางแสดงค่าสถิติพื้นฐาน (ค่าเฉลี่ย และค่าเบีย่งเบนมาตรฐาน) พบว่า ค่าเฉลี่ยวินัยใน

ตนเองของนักเรียนทีเ่ล้ียงดูตามวิธีที่ 1 มีค่า 3.42 ส่วนวิธีที่ 2 มีวินัยในตนเองเฉลีย่ 1.85 และวิธีที่ 3 มี

ค่าเฉลี่ย 4.66 
 

 
 

จากตารางเปน็ตาราง ANOVA  

 เป็นการทดสอบสมมุติฐานว่า H0     : 1   =   2   =  3  

    H1     : 1      2      3   

หรือ มีค่า  อย่างน้อย 1 คู่ทีไ่ม่เท่ากัน 

พบว่า ค่า F = 6.119 sig = 0.010 (< 0.05) หมายความว่า ปฏิเศษ H0 ยอมรบั H1 ซ่ึงแสดงว่า 

H1     : 1      2      3  หรือ มีค่า  อย่างน้อย 1 คู่ทีไ่ม่เท่ากัน ดังนั้นสรปุได้ว่าวิธีการเลี้ยงดู

ที่ต่างวิธีกนัทาํให้นกัเรียนมีวินัยในตนเองแตกต่างกัน 

 เมื่อเราพบว่าวิธีการเล้ียงดูที่ต่างกันทําให้วินัยในตนเองของนักเรียนต่างกนักจ็ะต้องดูต่อไปว่า

แล้ววิธีการเล้ียงดูคู่ไหนที่แตกต่างกันจาก Post Hoc Tests 

 

 

 

Descriptives

DISCIP

7 3.4286 1.8127 .6851 1.7521 5.1050 1.00 5.00

7 1.8571 1.5736 .5948 .4018 3.3125 1.00 5.00

6 4.6667 .5164 .2108 4.1247 5.2086 4.00 5.00

20 3.2500 1.8028 .4031 2.4063 4.0937 1.00 5.00

1.00

2.00

3.00

Total

N Mean
Std.

Deviation Std. Error
Lower
Bound

Upper
Bound

95% Confidence
Interval for Mean

Minimum Maximum

ANOVA

DISCIP

25.845 2 12.923 6.119 .010

35.905 17 2.112

61.750 19

Between Groups

Within Groups

Total

Sum of
Squares df

Mean
Square F Sig.
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Post Hoc Tests 
 

 
 

จากตารางเปน็ตารางแสดงการเปรียบเทียบความแตกต่างรายคู่โดยวิธี LSD 

 โดยมีสมมุติฐานดังนี้ ji0 :H   

    ji1 :H   

 วิธีที ่1 กับวิธีที่ 2 พบว่า sig = 0.059 (> 0.05) จะยอมรับ H0 ซ่ึงแสดงว่า วิธีการเล้ียงดูวิธีที ่1 

และวิธีที ่2 ทาํให้นกัเรียนมีวินัยในตนเองไม่แตกต่างกนั (เท่ากัน) 

 วิธีที่ 1 กบัวิธีที่ 3 พบว่า sig = 0.144 (> 0.05) จะยอมรบั H0 ซ่ึงแสดงว่า วิธีการเล้ียงดูวิธีที ่1 

และวิธีที ่3 ทาํให้นกัเรียนมีวินัยในตนเองไม่แตกต่างกนั (เท่ากัน) 

วิธีที่ 2 กับวิธีที่ 3 พบว่า sig = 0.003 (< 0.05) จะปฏิเศษ H0 ยอมรบั H1 ซ่ึงแสดงว่า วิธีการ

เล้ียงดูวิธีที่ 2 และวิธีที ่3 ทาํให้นกัเรียนมีวินัยในตนเองแตกต่างกัน 

 

การนําเสนอผลการวิเคราะห์ด้วย One-way ANOVA 

ตาราง 5  แสดงการวิเคราะห์ความแปรปรวนของความมีวินัยในตนเองของนักเรียนระหว่าง

วิธีการเลี้ยงดู 

แหล่งความแปรปรวน SS df MS F Sig. 

ระหว่างกลุม่ 

ภายในกลุม่ 

25.845

35.905 

2

17 

12.923

2.112 

6.119* 0.010 

รวม 61.750 19  

* P<0.05 

Multiple Comparisons

Dependent Variable: DISCIP

LSD

1.5714 .7768 .059 -6.75E-02 3.2104

-1.2381 .8085 .144 -2.9440 .4678

-1.5714 .7768 .059 -3.2104 6.751E-02

-2.8095* .8085 .003 -4.5154 -1.1037

1.2381 .8085 .144 -.4678 2.9440

2.8095* .8085 .003 1.1037 4.5154

(J) CARE
2.00

3.00

1.00

3.00

1.00

2.00

(I) CARE
1.00

2.00

3.00

Mean
Difference

(I-J) Std. Error Sig.
Lower
Bound

Upper
Bound

95% Confidence
Interval

The mean difference is significant at the .05 level.*. 
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 จากการวิเคราะห์คะแนนความมีวินัยในตนเองของนักเรียนระหว่างวิธีการเล้ียงดู พบว่า วิธีการ

เล้ียงดูที่ต่างกันทาํให้วินยัในตนเองของนักเรียนต่างกันอย่างมีนยัสําคัญทางสถิติที ่0.05 ซ่ึงจะต้องมีการ

ทดสองรายคู่ต่อไปดังแสดงผลในตารางที่  

 

ตาราง 6  แสดงการเปรียบเทียบค่าเฉลี่ยของความพึงพอใจในการทํางานของพนักงานในฝ่าย

ต่างๆ 

วธิีการเลี้ยงดู ค่าเฉลี่ย วธิีการเลี้ยงดู

1 2 3 

1 3.42   

2 1.85  * 

3 4.66   

* P<0.05 

จากการเปรียบเทียบรายคู่ พบว่า ค่าเฉล่ียของความมีวินัยในตนเองของนักเรียนวิธีการเล้ียงดู

วิธีที่ 2 แตกต่างกับวิธีที่ 3 อย่างมีนัยสําคัญทางสถิติที่ 0.05 
 

 

การวิเคราะห์ค่าสหสัมพนัธ์เพียร์สัน (Pearson Product Moment Correlation) 

การวิเคราะห์ค่าสหสัมพันธ์เพียร์สันเปน็การวิเคราะห์เพ่ือหาความสัมพันธ์ระหว่างตัวแปร โดย

ทั้งสองตัวแปรจะต้องมีระดับการวัดตั้งแต่อันตรภาคข้ึนไป เช่น 

 ความสัมพันธ์ของคะแนนการสอบวิชาคอมพิวเตอร์ (X) กับวิชาสถิติ (Y) ของนักศึกษา 

 ความสัมพันธ์ของความสูง (X) กับน้ําหนกั (Y) ของนักเรียน 

 ความสัมพันธ์ของราคาส่งออก (X)  กับปริมาณส่งออก (Y) ของลําไย 

 ความสัมพันธ์ของตัวแปร 2 ตัว X และ Y อาจจะมีความสัมพันธ์อยู่ในรูปแบบต่างๆ เช่น 

ความสัมพันธ์ที่มีลักษณะแนวโน้มเปน็เส้นตรง หรือเส้นโค้งพาราโบลา หรือแบบอ่ืนๆ กไ็ด้ แต่ในทีน่ี้จะ

กล่าวถึงเฉพาะความสัมพันธ์ทีม่ีลักษณะแนวโน้มเป็นเส้นตรง ซ่ึงแบ่งออกเป็น 2 แบบ คือ 

 1. ความสัมพันธ์เชิงบวก (positive Correlation) เปน็ความสัมพันธ์ ที่เรียกว่า แปรผันตามกนั 

กล่าวคือ ถ้า X มีค่ามากขึ้น ค่าของ Y ก็จะมีแนวโน้มมากขึ้นด้วย แต่ถ้า X มีค่าน้อยลง ค่าของ Y ก็จะมี

แนวโน้มน้อยลงด้วย 

 2. ความสัมพันธ์เชิงลบ (negative Correlation) เปน็ความสัมพันธ์ ที่เรียกว่า แปรผันกลับกัน หรือ

แปรผกผัน กล่าวคือ ถ้า X มีค่ามากขึ้น ค่าของ Y ก็จะมีแนวโน้มลดลง แต่ถ้า X มีค่าน้อยลง ค่าของ Y ก็

จะมีแนวโน้มเพิ่มข้ึนด้วย 
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                                        0        
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                                0  0   0 

                       0    0  0 

                  0    0 

               0    Y 

 

     ความสัมพันธ์เชิงบวก 

    X     

 0 0 

                 0    0                                   

        0 0 0             

                             0  0 0    

                                0   0  0 

                                         0       Y        

 

                    ความสัมพันธ์เชิงลบ 

 

 

 การพิจารณาความสัมพันธ์เชิงเส้นตรงของ X และ Y ว่ามีความสัมพันธ์มากน้อยเพียงใด

สามารถคํานวณความสัมพันธ์นั้นออกมาเปน็ค่าของตัวเลข ในที่นี้จะกล่าวถึงวิธีการของเพียร์สัน ที่

เรียกว่า สัมประสิทธิ์สหสมัพันธ์ (Correlation Coefficient) ซ่ึงมีสูตรในการคํานวณคือ 

 ถ้าสมมตุิให้ r แทน สัมประสิทธิ์สหสัมพันธ์ ของข้อมูลตัวแปรคู่ X และ Y ดังนั้นจะได้ว่า 
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โดยสัมประสิทธิ์สหสัมพันธ์ (r) จะมีค่าอยู่ระหว่าง -1 ถึง 1 

ถ้า r = 1 หมายความว่า ตัวแปร X และ Y มีความสัมพันธ์เชิงบวกแบบตามกนัโดยสมบูรณ์ 

ถ้า r = 0 หมายความว่า ตวัแปร X และ Y ไม่มีความสัมพันธ์เชิงเส้นตรง 

ถ้า r = -1 หมายความว่า ตัวแปร X และ Y มีความสัมพันธ์เชิงลบกันโดยสมบูรณ์ 

 

 การทดสอบสมมุติฐานเกี่ยวกับค่าความสัมพันธ ์(สมประสิทธิ์สหสัมพันธ์) 

ลักษณะการตั้งสมมตุิฐาน H0     :     =   0 (ไม่มีความสัมพันธ์กัน) 

H1      :         0 (มีความสัมพันธ์กัน)  หรือ 

H0     :     =   0 (ไม่มีความสัมพันธ์กัน) 

H1      :     >   0 (มีความสัมพันธ์กันทางบวก) หรือ 

H0     :     =   0 (ไม่มีความสัมพันธ์กัน) 

H1      :     <   0 (มีความสัมพันธ์กันทางลบ) 

 

สถิติทีใ่ช้ทดสอบ 

2n
)r1(

r
t

2




   2ndf   

 

การพิจารณาหากค่าสถิติ t ที่คํานวณได้ไม่มีนัยสําคัญทางสถิติ (Sig >  ) นั่นคือยอมรับ H0 

แสดงว่าไม่มีความสัมพันธ์กันระหว่างตัวแปร แต่ถ้าค่า t ที่คํานวณได้มีนัยสําคัญทางสถิติ      (Sig < 
) นั่นคือปฏิเสธ H0 ยอมรับ H1 แสดงว่ามีความสัมพันธ์กันระหว่างตัวแปร (สัมพันธ์ทางบวก หรือสัมพันธ์

ทางลบ) 

 

ขั้นตอนการทดสอบค่าสหสัมพันธ ์

 

เปิดโปรแกรม SPSS 

คลิก Analyze > Correlate > Bivariate ดังภาพที่ 43 
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ภาพที่ 43 

 

จะได้ดังรูปที่ 44 

 
ภาพที่ 44 

 

ให้เลือกตัวแปรที่เราต้องการหาความสมัพันธ์ในชอง  มาไว้ในช่อง  ในทีนี้ให้ท่านเลือกตวั

แปร eanxiety  anxiety  stress  หลังจากนั้นให้ Click ที ่ปุ่ม OK ดังภาพที่ 45 
 

 

 

 


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ภาพที ่ 45 

 

ผลการวิเคราะห์ จากการประมวลผล ดังน้ี 
 

Click  

  Correlation Coefficients  หมายถึง ค่าสหสมัพนัธ์ท่ีเราตอ้งปารวิเคราะห์ โดยปกติ
โปรแกรมจะเลือก ค่าสหสมัพนัธ์ของเพียร์สนั 
     Test of Significant หมายถึง เลือกวา่จะทดสอบนยัสาํคญัทาสถิติเป็นแบบ หางเดียว (One 
tailed)  หรือ สองหาง (Two tailed) 
   Flag Siginficant Correlations หมายถึง ใหแ้สดงดอกจนั (*) ท่ีค่าสหสมัพนัธ์ท่ีมีนยัสาํคญัทาง
สถิติ 
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 Pearson Correlation หมายถึง ค่าสหสัมพันธ์เพียร์สัน 

 ระดับนัยสําคัญทางสถิติ (sig) ถ้ามีค่า sig น้อยกว่าหรือเท่ากับ .05 แสดงว่าค่าสหสัมพันธ์

นั้นมีนยัสําคัญทางสถิติ แต่ถ้า sig มากกว่า .05 ค่าสหสัมพันธ์น้ันไม่มีนัยสําคัญทางสถิติ 

 N หมายถึง จํากลุ่มตัวอย่างที่เข้ากระบวนการวิเคราะห์ 

 

ผลการวิเคราะห์คาสหสัมพันธ์พบว่า   

ตัวแปร EANXIRTY มีความสัมพันธ์ทางบวกกับตัวแปร ANXIETY อย่างมีนยัสําคัญทางสถิติที่

ระดับ .05 (sig <0.05) โดยมีค่าสหสัมพันธ์เพียร์สันเท่ากับ .269    

ตัวแปร EANXIRTY ไม่มีความสัมพันธ์กับตวัแปร stress (r= .047,sig >0.05) หรือมีความสัมพันธ์

กันอย่างไม่มีนัยสําคัญทางสถิติ   

 ANXIETY ไม่มีความสัมพันธ์กับตัวแปร STRESS (r= .086, sig >0.05) หรือมีความสัมพันธ์กัน

อย่างไม่มีนยัสําคัญทางสถิติ 
 

ตัวอย่างที่ 4 ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการเรียน 

 จากตัวอย่างที่ 4 มีตัวแปรที่เกี่ยวข้อง 2 ตัว คือ 1) ความถนัดทางการเรียน (วัดออกมาเปน็

ตัวเลข) และ  2) ผลสัมฤทธิท์างการเรียน (วัดออกมาเป็นตัวเลข) 

 ความถนัดทางการเรียน ผลสัมฤทธิ์ทางการเรียน 
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 ความถนัดทางการเรียน ผลสัมฤทธิ์ทางการเรียน 
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การตั้งสมมุติฐาน H0     :     =   0 

H1      :     >   0 

 โดยที ่   คือ ความสัมพันธ์ระหว่างความถนัดทางการเรียนกบัผลสัมฤทธิ์ทางการเรียน 

 สถิติทีจ่ะใช้ในการทดสอบ คือ ค่าสหสัมพันธ์แบบเพียร์สัน 

 

ข้ันตอนการวิเคราะห์ 

 เปิดโปรแกรม Spss จะได้ภาพที่ 46 
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ภาพที่ 46 

 

 ทําการกําหนดชื่อตัวแปรและลงรหัสข้อมูล (ตามข้ันตอนข้างต้น) ดังภาพที่ 47 
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ภาพที่ 47 

 

คลิก Analyze > Correlate > Bivariate ดังภาพที ่48 
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ภาพที่ 48 

 

จะได้หน้าจอดังภาพที่ 49 ทําการใส่ตัวแปรที่ต้องการวิเคราะห์  

 ในช่อง Variable เลือกตัวแปร skill และ ach (หาความสัมพันธ์ของ 2 ตัวนี้) แล้วคลิก OK 

 
ภาพที่ 49 
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ผลการวิเคราะห์จะได้ดังน้ี  

 

Correlations 

 

 
 

จากตารางเป็นการการทดสอบค่าสหสัมพันธ ์

เป็นการทดสอบสมมุติฐาน H0     :     =   0 

H1      :     >   0 

พบว่า ค่า sig = 0.016 (<0.05) หมายความว่า ปฏิเศษ H0 ยอมรบั H1 ซ่ึงแสดงว่า                H1      

:     >   0 ดังนั้นสรุปได้ว่าความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการเรียน 

โดยมีความสัมพันธ์กัน 0.530 

 

การนําเสนอผลการทดสอบนัยสําคัญค่าสัมประสิทธิ์สหสัมพันธ์ 

ตาราง 7  แสดงการทดสอบความสัมพันธ์ระหว่างความถนัดทางการเรียนกับผลสัมฤทธิ์ทางการ

เรียน 

ความสัมพันธ์ระหว่าง ค่าสัมประสิทธิ์สหสัมพันธ ์

ความถนัดทางการเรียนกับผลสัมฤทธิ์ทางการ

เรียน 

0.53*

* P<0.05 

 จากการทดสอบพบว่า ความถนัดทางการเรียนมีความสัมพันธ์ทางบวกกับผลสัมฤทธิ์ทางการ

เรียน อย่างมีนัยสําคัญทางสถิติที่ 0.05 และมีความสัมพันธ์กันสูงถึง 53% 

 
 

 

 

 

Correlations

1.000 .530*

. .016

20 20

.530* 1.000

.016 .

20 20

Pearson Correlation

Sig. (2-tailed)

N

Pearson Correlation

Sig. (2-tailed)

N

SKILL

ACH

SKILL ACH

Correlation is significant at the 0.05 level (2-tailed).*. 
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การวิเคราะห์ ไคสแควร์ (Chi - Square) 

 

การทดสอบ ไค-สแควร์  มีการทดสอบ 2 กรณีคือ 

1. กรณีตัวแปรเดียว  เป็นการทดสอบเพื่อดูว่าความถี่ทีสั่งเกตได้แตกต่างจากความที่ที่

คาดหวังหรือไม่ หรือ อาจกล่าวได้ว่าจํานวน  ความถี่หรือสัดส่วนทีป่รากฏในแต่ละ

กลุ่มนั้นแตกต่างกันหรือไม่ 

2. กรณี 2 ตัวแปร เปน็การทดสอบความสัมพันธ์ระหว่างตัวแปรสองตัวที่ข้อมูลอยู่ใน

รูปจํานวน ความถี่ หรือร้อยละ 

 

ขั้นตอนการวิเคราะห์ 

 กรณีตัวแปรเดียว 

Analyze > Nonparametric > Chi-Square 

สมมติฐานการวิจัย 

 จํานวนครูอาจารย์มีระดับความวิตกกังวลในสถานการณ์แตกต่างกัน 
 

 
 

ภาพประกอบ 50 

 



  
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ผลการใช้คําส่ัง 
 

 
 

ภาพประกอบ 51 

 

      Test  Variable List  หมายถึงตัวแปรที่เราต้องการทดสอบ สามารถเลือกได้ 1 ตัว  ตัวแปรที่ใช้ 

ควรเปน็ตัวแปรชนิด category เช่น เพศ  อาชีพ ศาสนา หรือตัวทีม่ีข้อมูลเป็นจํานวนหรือ

ความถี่  ในทีน่ี้เลือกตัวแปร e1 ซ่ึงเปน็ข้อคําถามเกี่ยวกับความวิตกกังวลในสถานการณ์ของครู

อาจารย์ โดยมีระดับความวิตกกงัวลตั้งแต่น้อยที่สุด (1) จนถึงมากที่สุด (5) โดยข้อมูลที่ได้ในแต่

ละระดับจะเปน็ความถี ่

       Expect Range หมายถึง เปน็การระบุช่วงของค่าตัวแปรที่ต้องการวิเคราะห์ สามารถเลือกได้

ทางใดทางหนึง่ 

Get  from data   หมายถึง จะวิเคราะห์ทกุค่าของตวัแปร เช่น อาชีพ มี 5 อาชีพ ก็จะนํา 

ตัวแปรอาชีพ ที่มีค่าทัง้ 5 มาวิเคราะห์ ในกรณีนี้นําตัวแปร e1 มาวิเคราะห์ซึ่งมี

ทั้งหมด 5 ระดับ 

Use  Specific range หมายถึง เลือกค่าบางค่าของตัวแปรมาวิเคราะห์ ซ่ึงต้องระบคุ่าต่ําสุดและ

สูงสุดของตัวแปร เช่น อาชีพ กําหนดค่าต่ําสุด (Lower) มีค่าเปน็ 1 และ

ค่าสูงสุด(Uper) มีค่าเปน็ 3 หมายถึงนําเฉพาะ 3 อาชีพแรกเท่านั้นมาวิเคราะห ์

      Expected Value   เป็นการระบุค่าที่คาดหวัง (E) ของแต่ละค่าตัวแปร หรือระบุค่าสัดส่วนของ

แต่ละค่าของตัวแปร โดยมีทางเลือก 2 ทาง คือ 



 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๗๔ 
 

All  Categories equal หมายถึง ต้องการทดสอบว่าจํานวน ความถีห่รือสัดส่วนของระดับต่าง

ของตัวแปร ในแต่ละกลุ่มเท่ากันหรือไม่ 

Value    หมายถึง ต้องการทดสอบว่าสัดส่วนของแต่ละระดับหรือกลุ่มเปน็ไปตามที่คาดไว้ 

หรือไม่ โดยต้องระบุสัดส่วน จํานวน หรือความถี่ลงไปในแต่ระดบัหรือกลุ่ม โดย 

กําหนดทีละค่าของแต่ระละดับหรือกลุ่ม แล้ว Click ที่ปุม่ Add 

 ในที่นี้จะเปน็การทดสอบ ตวัแปร e1 โดยใช้ All categories equal  ซ่ึงเปน็การทดสอบว่าจํานวน

ของครูอาจารย์ในแต่ละระดับเท่ากันหรือไม่  เมื่อกําหนดค่าต่างเสรจ็แล้ว ให้ Click ที่ ปุม่ OK ผลทีไ่ด้ดัง

ปรากฏดังน้ี 

 
 

 ตาราง แสดงความถี่ โดย 

Observed N  หมายถึง จํานวนความถีจ่ากการสังเกต(O) หรือความถี่ที่ได้จากการเก็บ

รวบรวมข้อมลู 

Expectd N    หมายถึง  ความถี่คาดหวัง (E)  ซ่ึงในที่นี้ในแต่ละระดับมีค่าเท่ากันหมดคือ 

18 คน 

Residual      หมายถึง  ผลต่างระหว่างความถี่จาการสังเกตกับความถี่คาดหวัง (O -E) 

ผลการวิเคราะห์  

 Chi – square   หมายถึง ค่าสถิติไคสแควร์ ซ่ึงพบว่ามีค่าเท่ากบั 23.333 

 df   หมายถึง ค่าองศาอิสระ มาจาก K-1 (จํานวนกลุ่มหรือระดับลบด้วยหนึ่ง) 

 





 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๗๕ 
 

 Asymp.Sig  หมายถึงระดับนัยสําคัญทางสถิติ ของค่าไคสแควร์ (23.33) ซ่ึงพบว่า

มีค่าต่ํากว่า .05  (Sig = .000)  จึงปฏิเสธ H0   :  จวนของครูอาจารย์ในแต่ละระดับมีค่าเท่ากัน และ

ยอมรบั H1 : จํานวนครูอาจารย์ในแต่ละระดับแตกต่างกัน  

 ผลการทดสอบสมมติฐาน สรุปได้ว่า จํานวนครอูาจารย์ในละระดับ(กลุ่ม)แตกต่างกันอย่างมี

นัยสําคัญทางสถิติทีร่ะดับ .01 

 

การทดสอบกรณี 2 ตัวแปร 

  เป็นการทดสอบเพ่ือดูว่าตวัแปรสองตัวมีความสัมพันธ์กันหรือไม่ 

 

ขั้นตอนการทดสอบ 

Analyze > Descriptive Statistics > Crosstabs 
 

 
 

ภาพประกอบ  52 

 

 

 

 

 

 



 

คู่มือแนวปฏิบัติท่ีดีในการทํางานวิจัยในช้ันเรียน  หน้า ๗๖ 
 

ผลที่ได้จาการใช้คําส่ัง ดังภาพประกอบ 53 
 

 
 

ภาพประกอบ  53 
 

  ตัวแปรทีม่ีอยู่ทั้งหมดใน File ข้อมูล 

 Row หมายถึง ตัวแปรที่เราต้องการทดสอบหาความสัมพันธ์ แต่กําหนดให้เป็นส่วนแถวของตาราง

ผลการวิเคราะห์ 

Colums หมายถึง ตัวแปรที่เราต้องการทดสอบหาความสัมพันธ์ แต่กําหนดให้เป็นส่วนColumnของ

ตารางผลการวิเคราะห ์

ในภาพประกอบ 53 นี้ผู้วิจัยสนใจที่จะทดสอบความสัมพันธ์ระหว่างเพศกบัความวิตกกังวลใน

สถานการณ์ (Geanxie) ซ่ึงเดิมตัวแปรนี้มีการ Recode ให้มีข้อมูลเป็นความความถี ่ ซ่ึงจะทําให้ตัวแปร

เป็นตัวแปรชนิด Category โดยกําหนดให้เพศ อยู่ใน Row(s) และ geanxie อยู่ที ่Column(s) หลังจากนัน้ 

ให้ Click ที่  ปุม่ Statistics... ได้จะปรากกฎดังภาพประกอบ  54 
 







 
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ภาพประกอบ 54 

 

จากภาพประกอบ 54  ให้ check ที่ Chi-square และ Click ที่ Continue  จะได้ผลกลับไปเหมือน

ภาพประกอบ 53 แล้ว Click ที่  ปุม่  Cells...  จะปรากฏผลดังภาพประกอบ 55 

 
 

     ภาพประกอบ 55 

 

 

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 จากภาพประกอบ 55 ให้ Check ที่ Observed และ Expected เพื่อให้แสดงค่าทีสั่งเกตได้กับค่า

คาดหวัง แต่ถ้าต้องการให้แสดงค่าร้อยละด้วยให้ Check ที ่กลุ่ม Percentage  หลังจากนั้นให้ Click ที่ 

Continue 

 

ผลการวิเคราะห์ 

 
 

 เป็นการแสดงค่าความถี่ทีไ่ด้จากสังเกต()และค่าความถี่ที่คาดหวัง() จําแนกตามกลุ่มของ

ตัวแปรทั้งสองตัวแปร  

 
 

 เป็นผลการวิเคราะห์ ค่าไคสแควร์ (ดู Pearson Chi-Square) พบว่า มีค่าเท่ากับ 19.469 , df = 4 

sig = .001 แสดงว่า ตัวแปรเพศและความวิตกกังวลมีความสัมพันธ์กันอย่างมีนยัสําคัญทางสถิติทีร่ะดับ 

.001 หรือกล่าวได้ว่า ความวิตกกังวลใสถานการณ์ขึ้นอยู่กบัเพศ 

  


